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4 HSEO
4.1 & HER

AT O G T — Ak, W& At Z R EEE 9-32 VDC, #HEHMEH 12
VDC.

N RAME 2 O & T TR A s b, WAUE &I FR R 12VDC, V2.0 KBS
FECA B T 0 05 TR D RE AR AL TR IE A, BT AT LA 9-32VDC EL4n FR A Ll

B LARRE T IFEL8 13.5W (IALMED

4.2 BT
RS-LiDAR-32 WOt E ik M ENL IR mm 5l rgisk CRRIE/ZdE2e) 195 —umfiH 1

FRAUER SH1.25 kv, Bdkim TEH T 5~ Bs.
F 7 {# B RS-LiDAR-32 A% SH1.25 i 148 A\ Interface BOX A% B[R 47 & o

PINL

ITEN NO. CABLE COLOR DESCRIPTION QaTty

1 Blue GPS REC i}

2 Green GPS PULSE 1

3 Red +12V i}

4 Yellow +12V 1

5 White GND i} i
6 Black GND 1 e
7 Brown LiDAR Ethernet RX- 1

8 Brown white LiDAR Ethernet RX+ 1

9 Orange LiDAR Ethernet TX- 1

10 Orange white LiDAR Ethernet TX+ 1

FEl 2 Hetdesi T-4HIIT 5
AR P 11 5
RS-LiDAR {8 FHMU##% M, FE A MU AL B K MBI 1 oK. ik 1 B A

5
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RG] EE AR

5 — e KX

Pin Wire Color Function

1 Red +12V

2 Yellow +12V

3 White GROUND

4 Black GROUND

5 Green GPS PULSE

6 Blue GPS REC

7 Brown LiDAR Ethernet RX-
8 Brown white LiDAR Ethernet RX+
9 Orange LiDAR Ethernet TX-
10 Orange white LiDAR Ethernet TX+

3 fiddE 5 TS

4.3 Interface Box £ 1}t BH

RS-LiDAR-32 H) %Ki\ $25X Interface BOX.

RS-LiDAR-32 [ ff Interface BOX HA LGN S &ML, FIFLIL RSN . A
2] GPS fi N2, Houm 5. WA KA (DC5.5-2.1 B) , RS-LiDAR-32 ¥4
(RJ45 MR ) LM GPS 4%\ (SH1.0-6P BFRE) . fiiffiis 0 &K 3 K, HHih
LK 7RG L R Robosense BAR IR BFUOAEIARAARE, $0& GPS H Ay SR 1P 22

SRATWITR, 5% DRI B A7 B4 B s

BT

BNERIT
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Pin No. V2.0 and later versions Other versions
1 GPS PULSE GPSREC
2 +5V GPS PULSE
3 GND GND
4 GPS REC NC
5 GND NC
6 NC +5V

VR : RS-LiDAR-32 H)“dh” 54M 48 RS EREN, ARGt R 6k (“d”) 5 GPS

4 Interface BOX #:15E X

RGH) H” b U AR R B L R S

HURIE R S, 2D R A SRR AT e RIS dar U, SRt B Y H R R AT SR
MENFERAT S, AR R AT K, Interface BOX JENARIFURAS . W0 N TR AT Kt
YR T (RIS BRI, i A A r P AN A 5 IR, A R A I, R Interface BOX AJ
RE iR, HR) 4EE.

GPS # % X: GPSREC & GPS UART #i\; GPSPULSE & GPS PPS #i\.

R 2% 3% 113845 EIA/TIA568 Frifi.

F YR 4% D F A e DC 5.5-2.1 #£0.
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5 EfEHY

RS-LiDAR-32 55 H i 2 [R] R385 K FH LUK A2, {32 H] UDP B3, i 60 AT I Al SR 2
MSOP .1 DIFOP B, CH i ¥ J UDP B PS4 1290byte iE K, HH 1248byte Ay
BHRERAT, H A 42byte y UDP 49 JF % . RS-LiDAR-32 WS H T BLE, ) BRI K [
SE TP Ml 548, 4R R R

=2 WA SR ER

IP bk MSOP &5 05 DIFOP H.i% 15
RS-LiDAR-32 192.168.1.200
- 6699 7788
FEL 192.168.1.102

B BRI MAC MBI 7E L) WA B 1Y, (FZ B % MAC Hhhil nT A4S 75 R gl .

B RO, 7R AT FUIK Y TP W BN 58 A — B b, 911 192.168.1.x(x HIHK
HYE N 1~254), TR N 255.255.255.0. # NEN & MKECE S R, HIER K& IFE
H wireshark UL B #5fai t 6BEAT 707 -

RS-LiDAR-32 1 H ik [A) RIS PN 2 200 =28, — YR ML N 38k

> EHARAHE PR MSOP, HBEORE AT ORIIES, M, RSRGE R

0B H 4 O
> B S MY DIFOP, KOk T i AR 1 5B e B 45 S5 4 H 45 FU
> HPRRE A UCWP, H AT URYE B O 7K, MBSO H AR i E

®=3 WABLUW

(il a) &K &5 Dide KA EPN) R I% 8]
Main data St "
amn data Streat MSOP FRSUEEH | UDP | 1248byte | £ 0.667ms
Output Protocol
Device Information . e
DIFOP WAAE B UDP 1248byte | #] 100ms
Output Protocol
User Confi ti LERESH
Ser . ontigtration UCWP . %é UDP 1248byte INF
Write Protocol LITPN

E: FERENE A EBOP A9 AT (1248byte ) A4 BT Rk Fe R Lo
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5.1 EHERBH B (MSOP)

FHIER L P Main data Stream Output Protocol, fij#k: MSOP

/0 KA. sttt Fi AT

Bl 154 6699
MSOP 1, 5¢ i — 4 B AH S H R i e, B FEBOCIERE . RIS RAE . KF e s A
FEE AN [A] 8% . MSOP f [0 & ak i Kl 1248 7715, Hrb 42byte [ [F W5k Header ,

1200byte MIEHESLX [ (3t 12 4> 100byte ] data block) , LA 6byte WiE Tail.
R[] 5 B R R AR S A T B TR

42 byte
|

Oxffee Oxffee Oxffee Oxffee
42 byte
{2130 Azimuth 1 Azimuth 2 Azimuth n Azimuth 12
byte 4 B¢
(1559 channel data 1 channel data 1 channel data 1 channel data 1

MSOP Packet (1248 byte)
data packet

12*100hyte= 1200byte 6byte

channel data 2

channel data 2

channel data 2

channel data 2

channel data ... channel data ... channel data ... channel data...
channel data 16 channel data 16 channel data 16 channel data 16
channeldatal7 channeldata 17 channel data 17 channeldata 17
channel data18 channel data 18 channeldata18 channel data 18
channel data ... channel data ... channel data ... channel data ...
channel data 31 channel data 31 channel data 31 channel data 31
channel data 32 channel data 32 channel data 32 channel data 32

1 K R AR S R 0 T P s -

6 MSOP Packet ##iH € nEH

10
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Data block1 Data block 2 Data blockn Datablock 12
Oxffee 0xffee 0xffee Oxffee
42 byte
(21~30 Azimuth 1 Azimuth 2 Azimuth n Azimuth 12
byte time
stamp) channel data 1 channel data 1 channel data 1 channel data 1
channel data 2 channel data 2 channel data 2 channel data 2
. channel data.... h | data .. channel data ... channel data ...
Firstreturn s cannees
channel data 16 channel data 16 channeldata 16 channel data 16
channeldatal17 channel data 17 channel data 17 channeldata 17
Second channel data18 channel data 18 channeldata18 channeldata 18
return ——
channel data ... channel data .. channel data ... channel data ...
channel data 31 channel data 31 channeldata 31 channel data 31
channel data 32 channel data 32 channeldata 32 channel data 32

MSOP Packet (1248 byte)

data packet
12*100byte= 1200byte

6byte

7 XU [E[J MSOP Packet #(if 0 w SURE K

5.1.1  fisk

Wik Header 3t 42byte, FT-iR%| £t FOIT 4R A1 E

£ Header [f] 42byte #5145 8byte FH T #5614, il T 34byte 1, 21~30byte
AT AR, 28 31byte H TRRBOLEIAM A S, HRIEMIEE AR, N5 SEn)E T fd
H .

Header ff] 8byte & XN 0x55,0xAA,0x05,0x0A,0x5A,0xA5,0x50,0xA0, A VE A ALK 25
¥ 516

ST S B TR SRAC SR RGBT ), S 9308 1us, W LAk B9 it ) e LA
BARTEER 3 /NI IR 8 S B A AT -

5 31byte [IHOLE AL S AR RGN IR I F & 4 TR

11
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%% 4 LiDAR Model FrEN A

LiDAR Model (1 byte)

0x01 RS-LiDAR-16
0x02 RS-LiDAR-32

5.1.2 i He[X [a]

AR P X 8] /2 MSOP A, A& 28 1 I S 44, 3% 1200byte. ‘X HH 12 4> data block 41
B, B block KA 100byte, AR —4H 58 MM EEE % . Data block #' 100byte 1775 [H]
5. 2byte FIARENL, f# ] Oxffee F7n; 2byte ] Azimuth, FIR/AK e M EREE,
MG EXT RN 32 AN channel data, B8 1 H5EEN) 32 @iEFEE. GEEFS5®E
MR RS WSO EE 9 JEA)E SO
5.1.2.1 AEMHEE X

ERF4 Block 1, RS-LiDAR-32 %t (17K 1 #fy JZ fE /2 1% Block H 38 — NI 1 SO M e
(AR FEAE . A BB RIS T BEgmAS 2%, A FESmAS 28 1) A B0 A FEI B R, AKOP e i FEAEL 1Y)
SN 0.01 B

Plha, B9, HIBO AR XR:

KRB HAE S B0y A BT 2414 0x53, Oxdd.

Fra 4828 % 16bit, H 16bit LHF 5 ¥ A K. £TH: 0x53dd.

A TR T 21469,

% A 100,

AR 214.69 E.

H b, oK KAHHA A EALR 214.69 K.

A& REENABALA R LA ERE 13 F Y 4 EF @ P dedz B

5.1.2.2 channel data & X
1T RS-LiDAR-32 [ & i A/, channel data #54) Distance (¥ XA FT X 5, AL
MR DIFOP 40, vy th (1 [ A R A AT S AT X 43, (RISt AT AR OME 1 4% 1) HE ) e TRDEA T
WG St (2018 4 12 HUARTAILLSE)
(1) lem 3P A

12
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channel data /& 3byte, W F 3L 16 £, H A 0-14 AL H T8 &5 B4, 28 15 4
YENHFRELL; K—F AT RIS RER, WTFEFR.

%< 5 channel data 7/~ &

Channel datan (3 bytes)
2 byte Distance 1 byte Reflectivity
Flag[15] | Distance1[14:8] | Distance2 [7:0] | Reflectivity (% (5 &)

Distance J& 2byte, A4 cm, 73HPFZE lom.
channel data FIf#EHTI0 T

Blde, B 9P, RIRHHEQDZHEFM T b2 A 0x83, ,0x48 o

0x83 ! 1 {2 M E A H eI H 728K, RSENEFREE, B 7EREEHOG, 15 0x83 #
A 3 H A 10000011, AiFEfi=1, $#h T4l Hh 1, BBHEZH 742=0000011, A +stH A
3.

0x48 A 3B & 691&{, #HMAT3HH 72

B #: $6 % =5 & 69 F42*256+3E & 49 1842=3*256+72=840cm .

LA K 840%0.01=8.4m

Ht, AkeGMEEEZ 84K .

(2) 0.5cm M HEEERRAS
channel data #& 3byte, mMT 3L 16 £, T HEEE A K—FTHTERRRS
REE, WWTFEFR.

%% 6 channel data 7~ =&

Channel datan (3 byte)
2 byte Distance 1 byte Reflectivity
Distancel [15:8] | Distance2 [7:0] | Reflectivity(J 4t %15 5)

Distance 7& 2byte, .47y cm, 73##% 2 0.5cm.
channel data FIf#EHTI0 T
Blde, B 10, RIEIEE LAEHMEG Tk 2y 0x83, ,0x48 .
0x83 HIEH &Y Z1z, H#HhTaHH 131
0x48 A 3E#H 69M&f, #HMA oA H 72
B gb: 3B # =35 & 49 % 12256+ 38 & 69 /&2 =131*256+72=33608

ARAEIEH S E, #HMAAXK: 33608 *0.005=168.04m .

13



RS-LiDAR-32 FI /Tt

E b, AokbymEEE & 2 168.04 £

SRS FAT B R, HBAAGE LS R A5 B 5 iR, AR E BT
SRS R R G S AR RE, G S S A5 S AT RASE BSOS ANM AR I X 7

5.1.3 MiE
Wik (Tail) KFE 6byte, 4byte fi il {55, 2byte [ 0x00, OxFF.

5.1.4 FEE NTuEE

- 1 ©.800000 192.168.2.163 192.168.1.102 UDP 1290 6677 - 6699 Len-1248
2 0.801153 192.168.2.183 192.168.1.102 upP 1299 6677 + 6699 Len=1248
3 9.902355 192.168.2.183 192.168.1.162 UDP 1290 6677 + 6699 Len-1248
iF 4 0.803616 192.168.2.163 192.168.1.102 UDP 1298 6677 =+ 6699 Len-1248
il 5 0.0804768 192.168.2.163 192.168.1.102 uDP 1290 6677 » 6699 Len=1248

& Frame 4: 1298 bytes on wire (18320 bits), 1290 bytes captured (10328 bits) on interface @
> Ethernet II, Src: Dell 17:4a:cc (88:1c:23:17:4da:cc), Dst: Dell 48:60:3Ff (84:7b:eb:48:68:3F)
> Internet Protocol Version 4, Src: 192.168.2.183, Dst: 192.168.1.162

> User Datagram Protocol, Src Port: 6677 (6677), Dst Port: 6699 (6699)

> Data (1248 bytes)

84 7b eb 48 60 3f 88 1c 23 17 4a cc 08 @@ 45 90
@4 fc fc 40 40 00 88 11 74 92 P a8 B2 67 O a8
@1 66 1a 15 1a 2b 04 e8 EEWE; 55 aa 05 0a 5a a5
50 a@ 00 00 0D 00 9 6O 0O B0 BE 0O 00 °° 60 A0
60 00 0O 00 6D 00 0GR 6O OO ©O PG A0 00 ©° 60 A0
80 00 5a 5a ff ee 2b 78 ff ff bc 86 76 @9 Ff £F
bc 86 7f 87 86 7b 12 86 6e 88 86 7d Be B6 7d @9
@6 78 Be B6 81 @5 66 79 ©8 86 81 13 B6 6b 10 86
79 @d B6 8@ @c @6 7e Bc ff ff bc 86 75 @9 FF FF
bc @6 7f B7 @6 7a 11 @6 6d 88 @6 7c Be BE 7c 89
@6 78 Be B6 88 @5 66 79 ©7 96 80 13 06 6a 10 06
78 @d B6 7f @c @6 7f Oc ff ce 2b 78 ff £f bc 96
75 89 Ff Ff bc @6 7e @7 86 7c 11 86 6c B8 86 7b
@f 86 7c B9 @6 77 @e @6 7f 85 @6 79 B7 B6 7e 13
@6 68 18 B6 77 @d 06 80 Oc 86 7d Oc ff Ff bc 06
73 09 Ff Ff bc @6 7d @7 86 7b 11 @6 6c B8 86 7a
@Ff 86 7b B9 @6 78 Be @6 7f 85 @6 77 B7 B6 7e 13

8  MSOP packet JE/R

Bow Tine Bource Destination Protesal Length Infs
10.0000_ 192.168,1.200 102.168.1.182 LDP 1290 667746609 Len=1248
20.8018_. 192.168.1.200 192.168.1.182 unP 1298 6677+6699 Len=1248
39,0010 192.168.1.200 192.168,1.102 LDP 1298 667746699 Len=1248
49,8020 192.168,1.200 192.168,1,102 UDP 1290 667746699 Len=1248
50.0030. 192,168.1.200 102.168.1.182 UDP 1200 6677+6609 Len=1248
60.0030_ 192.168,1.200 102.168.1.182 LDP 1290 667746699 Len-1248

Frame 5; 1299 bytes on wire (10320 bits), 1299 bytes captured (18320 bits)

Ethernet II, Src: Dell 17:4a:cc (@@:lc:23:17:4atec), DSt: LefeHefe db:Sf:E1 Head.er:0x55=0xa3=0805=0803=0853:0x35:0x50:0x30

Internet Protocel Version 4, Srei 102.168.1.200, Dst: 192.168.1.f102
user Datagram Protocol, Src Port: 8677, Dst Port: 6699
Data (1248 bytes)
data block 1
h 11 data calculati
€8 5b 76 4b 5F @c 00 1c 22 17 4a cc OB 0@ 45 88 L [WK_...|#.1...E. distance flag 0x01: Atten byte 0x11
04 fc o7 o3 40 0: 80 11 distance byte -0x8348:; get atten 0x11
21 66 1a 15 1a 2b 04 e8 - 5
i e get distance :0x03&0x48; combine the byte :0x11
0 60 62 BCB 2] combine the bvte :0x0348; convert to decimal :17
as 16 3@ 13 -FF oo B3 ch g i g % ;
1f 87 @e 09 85 19 @6 87 57 87 85 b7 convert to decimal :840: result 217
86 b2 ob 88 41 1b 86 6a ©9 88 da @8 81 of 3b BB multiply by :1.0em;
3 Be 86 34 0a 86 90 @8 ©4 Ge @B 08 73 OC ©5 69 Al 24m-
ef 5f ff 92 @6 8f Pa B9 73 @6 @a ad 13 @6 93 1@ result =0 I
Sb 41 08 08 ©6 16 8a 26 1c @8 i 27 @0 of 13 09
73 @4 09 1b 3c 0a ba ob |ff ee 3 dd | @
d8 12 83 ea 16 67 93 @0 65 1a 1a 67 54 08 85 b7 data block 2

@7 86 9a 06 B6 bS 0a 88 45 18 86 69 00 88 de oe
81 9d 3b 88 f4 @e 86 39 @9 B6 92 17 04 Ge 85 @8
76 @b @5 60 e Sb 45 B7 5b 47 22 00 76 00 8a 1a
80 @a 6f 03 5b 41 13 88 ¢3 @b @a 31 pc Sh a4 1d
@0 ef 64 89 73 @8 Sb 36 Bc 0a bb of [f ee |53 ee
83 4a 12 87 d& 11 83 ea 1d 87 91 @8 85 18 15 87
57 @8 85 b7 @7 86 99 @a B6 bs 8b 88 54 3f B6 69
©a 88 f2 @d 81 of 3b 88 6 Bc 86 3b Pe df Ff 64
04 Ge @7 08 84 16 85 69 Ge 08 fc Ge 12 36 3b 09
bo 08 @a 1d 21 0a 6e 14 1d e 3b 88 c1 of 0a 33
2e 09 60 1c 00 ed 88 Ba 21 26 5b 36 69 0a d2 13

Azimuth n+2 calculati

second azimuth :0x53dd

get azimuth 0x53 & Oxdd
combine the byte  :0x53dd
convert to decimal :21469

divide by 100

result :214.69°
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& 9

Bo. Tiae Source Destination Frotessl Length Infs
1@.0000_ 192.168.1.200 192.168.1.102 UDP 1290 66776699 Len-1248
29.9016_ 192.168.1.200 192.168.1.1902 UDP 1290 6677+6699 Len=1248
39,0010 102.168.1.280 192.168.1.102 UDP 1298 6677+6609 Len=1248
48,9920 192.168.1.200 192.168.1.192 UDP 1290 6677+6699 Len=1248
50.9030.. 192.168.1.2080 192.168.1.182 UOP 1298 6677+6699 Len=1248
G0.0032_ 102.168.1.200 102.168.1.102 UDP 1200 66776600 Len=1248

Frame 5: 1290 bytes on wire (18320 bits),
Ethernet II, Src: Dell 17:4a:cc (@@:le:23
Internet Protocol version 4, Src:

1298 bytes captured (L
17:daicc), Dsti LefcHe:

192.168.1.208, Dst: 192.168.1

User Datagram Protocol, Src Port: 6677, Dst Port: 6699

fe_ab:5f:0
JLoz

8320 bits)

1cm 20 %% data block XEUEER

Header:0x55,0xaa, 0x05,0x0a,0x52.0xa5.0x50,0xa0

Data (1248 bytes)

data block 1

h 1 1 data calculati
ca 5b 76 4b 5F Oc 8@ 1c 23 17 4a cc 08 0O 45 00 distance flag 0=01; Atten byte 0x11
64 fc e7 e3 40 Gg 80 11 89 Si distance byte (0xB348; get atten 20x11
@1 66 1a 15 1a 2b 84 e8 c7 4 5 aa 05 2a 5a as 5 :
58 30 8 BB B P8 0@ 98 00 B0 BB B9 00 DO 00 09 get distance -Ux8348 combine the byte  :0x11
@8 88 82 Bc B3 18 PO 63 80 0D BB 94 04 DO B9 GO convert to decimal :17
ag 16 30 133 cb |83 a8 1] e .
1f 87 80 09 TE T 06 27 T G735 b7 08 26 07 64 convert to decimal: 33608 result 217
86 bz ob 88 41 1b 86 6@ 09 88 da 08 B1 5f 3b 88 multiply by :0.5cm:
3 @e 86 34 @a B6 90 08 04 6e BB 88 73 OC 05 69 . :
@f 5F f 02 86 Bf Ba @9 73 06 a od 13 06 93 19 result 168 Odm:
sh 41 @8 B8 6 16 83 26 1c o8 £d 27 09 ef 13 09
73 @4 09 1b 3c @a ba eb
dg 12 83 ea 16 87 03 89 a, T5 i3 87 54 08 85 b7 data block 2
@7 B6 9a 06 B6 bS Ba 82 45 1% 86 69 09 28 de ge E e
81 9d 3b 88 4 Ge 86 39 09 86 92 17 04 Ge 05 08 Azimuth nt2 cale
76 @b @5 69 @e 5b 45 @7 Sb 47 22 89 76 09 fa 1a second azimuth Ox53dd
@9 0a 6f B8 5b 41 1a 08 c3 8b Ga 31 Ac Sh 44 1d =
@9 ef @4 B9 73 88 Sb 36 8C Ba bb @f oo get azimuth :0x53 & O=xdd
83 43 12 87 d8 11 83 ea 1d &7 91 @8 85 18 15 87 combine the byvte  -0x353dd
57 OB 85 b7 67 B6 00 8a 86 bS Bb 88 54 3 86 69 : )
a 88 f2 od 81 of 3b 88 6 Ac 896 3b Ge df Ff o4 convertto decimal 21469
04 Ge ©7 08 B4 16 85 69 Oe 08 fc e 12 36 3b 09 divide by :100
be 88 Pa 1d 21 6a Ge 14 1d Ge 3b @8 c1 of 0a 33 14 £0°
2e 09 60 1c @9 ed 88 @a 21 26 Sb 36 69 0a d2 13 result 214.69

10 0.5cm 734 #% datablock X 3R @~

5.2 #&Z S5 i (DIFOP)

W5 B4 ¥, Device Info Output Protocol, f##%: DIFOP

/0 874 Wi, HK

B 154 7788

DIFOP /&y T & & 7515 (S/ND  [EFMRALE B EAHUIRSIHAMESE B MR
BER. REGE. BHUSITIE . BAPRAS . SRS KIS B e MR IE S i
B, B AT B S A A% 1 S P S EUN BARME R

—~ 5 1) DIFOP Packet P& M A AR Wk, BRIX, WiZE. SA8EEadt
1248byte: fUF 8byte [AZ Wik Header , 1238byte HI%HEIX, LLJ 2byte i) Tail.

Hn ORISR U1 T RS .

#H DIFOP fifisk
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RS-LiDAR-32 FI /Tt

%% 7 DIFOP Packet HI%#i#& 45 H4

Bog oy P B! Offset KZ (byte)
Header 0 DIFOP 7513k 0 8
Data 1 EER IR ST 2
2 PAIK Y 10 22
3 FOV % & 32 4
4 e 36 2
5 FLATLEAH A7 38 2
6 FAR AR A S 40 5
7 JEAR [ R A = 45 5
8 it ed 50 240
9 SIS E 290 1
10 R Z L IRA S 291 1
11 55 292 6
12 FEMbrEE 298 2
13 EIN;Z 5 300 1
14 AL FHEAAE S 301 2
15 I} (8] 303 10
16 BATIRE 313 18
17 e 331 11
18 B2 T 342 40
19 GPRMC 382 86
20 H#E H AR AE 468 96
21 K F R 564 96
22 e 660 586
Tail 23 it 2 1246 2

7E: % 4% P Header (DIFOP iR 3k) # 0xA5,0xFF,0x00,0x5A,0x11,0x11,0x55,0x55, T4k % &, 694
ERF7.

Tail WA R 2% 0x0F,0xF0,

B —IUE B AR E LA Z WH P T B Hr PR A
53 APERESAHI (UCWP)
F i & S5 N\ Pri:User Configuration Write Protocol, f&i#%: UCWP
1/0 KA ENRKEEA
UCWP SEHLDhfE: F P AR 75 SR T DA B & LRI . ISF(a] B bl S 3 R & .

—/NSEHE ) UCWP Packet 84 NG5 N RIE ML, B8 X . B4 (.3 48byte:
45 8byte [F]25 Wik Header A1 40byte [1I%¥E X 4.

16




RS-LiDAR-32 FI /Tt

AARNFERITMNSE T X,
% 8 UCWP Packet HIEERE 451

BRI s R Offset KE (byte)
Header 0 UCWP iR 51k 0 8
Data 1 IV IR SE 8 2
2 PLK 10 22
3 FOV % & 32 4
4 I} (8] 36 10
5 FLL B AH AR AL 46 2

7E: % % Header (UCWP iR #]3k) # 0xAA,0x00,0xFF,0x11,0x22,0x22,0xAA,0xAA, H % Header #7 4

NZFHEH 04T F 7], B 0xAA,0x00,0xFF,0x11.

FESEFE B, RS-LiDAR-32 JEAVEL & s R 48 S sl L ) AT RF RIS AT 1 RTC, fE7C GPS B
7 GPS {5}, JH 3 RS-LIDAR-32 J5 242 FH PC @3k UCWP i3 1 15 4 55 N B[], 75 i )
FIREIA B — A RGERS [A]THI .

JLBSE B AP LAY B R ERMLEE SR RUHLAE B DO A 25 77 98 PR GHE o

W F PR E T B LIDAR IP 24 192.168.1.105, H ] PC IP 24 192.168.1.225, Max_ADDR
4 001C23174ACC, MSOP {11}y 6688, DIFOP 4 1147 8899, FOV f2ihfAEN 0 Ji,
FOV 45 9 00 120 £, BFIE 2017 4E 3 H 10 H 9 5 45 4> 30 #) 100ms 200us, #%idH
600rpm, FLHLBAIAHAL 90 FERT, HR4E UCWP Packet FIAEAN25 785 (8 S, AT LUE IR R
FM IR A LiDAR &K 1% UDP BLHT AL E

9 BLERH

58 FHAAE EREANE KE (byte)
0xAA,0x00,0xFF,0x11,0x
Header 8
22,0x22,0xAA,0xAA
0x02
iH 600rpm 2
# P 0x58
0xCO
LiDAR IP 0xA8
192.168.1.105 4
(LIDAR_IP) 0x01
0x69
0xCO
‘] PC IP 0xA8
H i 192.168.1.225 X 4
(DEST_PC_IP) 0x01
0xE1
BeAg bk 0x00,0x1C,0x23,
001C23174ACC 6
(MAC_ADDR) 0x17,0x4A,0xCC
MSOP 3iii 1 (portl) 6688 0x1A20 2

17




RS-LiDAR-32 FI /Tt

MSOP ¥ 1 (port2) 6688 0x1A20 2
DIFOP it 1 (port3) 8899 0x22C3 2
DIFOP it -1 (port4) 8899 0x22C3 2
FOV #2461 & 0 0x0000 2
FOV 253 ff1 & 12000 0x2EE0 2
2017 & 0x11
3 H 0x03
10 H 0x0A
X 9 i 0x09
T 45 4y 0x2D 10
30 0x1E
100ms 0x00,0x64
200us 0x00,0xC8
HL LA AH 90 0x005A 2

o A P CAC B B, AFTRET P REUIX BB Tk BN, AR E N BN YIER;
RGN B RERN ZI B8, AH 28 S8 A2 T IR B & AT aa A Im AR Th A= 2K
7Z: RSVIEW #4424 T ilit UCWP X B X & A TANFR @AM, 3T UCWP U3 AR a9 1 LT &
UL A RSVIEW kit /7 A SOA %, BT AR E NN, FHBE, $LEBAZRERITHE, T

BRAEAHEEHZH R,

18




RS-LiDAR-32 I/ Tt

6 GPS [F

RS-LiDAR-32 T #M% GPS #idk, F H 44 GPS A H (0 18] [F] 55 A% 45 (1 R G [|], ]
LUK GPS & Hi ) GPRMC JH . £R47 2 DIFOP it .

6.1 GPS i8] [F]:5 R 3

GPS FHu i 48 17 ¥ 4% & 1% GPRMC 45 A1 PPS [64 k= 5, PPS [F)25 kK B4 20ms
% 200ms, GPRMC i o201 [F 2 ik o - F+3 500ms P 5€ il o

6.2 GPS f#

RS-LiDAR-32 714 GPS_REC 4% FHL T WA W fl, 7351004 3.3V TTL HLT-ARifEAT RS232
HSP AR s T U I B A E A RRAOSR X 43, RS 08 FF k909 TTL #%, 09 FFk
(174 RS232 Hhil; EF B FHRCATE &E K C H i C14.

RS-LiDAR-32 il & LI f) GPS_REC # MMy SH1.0-6P £, 5| i LNl 4 P
PR DX A S =, 0l

TTL H~F 51 JIE X

51 GPSREC #WCkH GPS it ) 3.3V TTL FL-FARE T & 1% ds;

511 GPS PULSE #4 GPS MUt fI1E TTL FIE k(5 5;

RS232 5 JAlE X

51841 GPS REC #2185k H GPS REDAa 1 i) R232 AL~ Hn Ak e 11 H0dls

51 GPS PULSE #£4% GPS #iluka th (R IE R Bk b {5 5, HISFEER 3.0V~15.0V;

FSAE I GPS Firth /& RS232 H CIPMN, T R A Bl 1ty /2 TTL B, 7522 F 4T

K RS232 ¥ TTL BRI, a2k B Jee LR -

6 ;zr:ms ‘ =
BRI [@’B)ecrs, J
OE— 0 ® wc EIEERIERIEE

© @ GND ® v

oe = e @

O v * CEEEEEEE

RS232 TO TTL g’
lf %
V0102 (FEMALE) . e—af]

11 RS232 % TTL Wi Fis#iidh
S| J+5V A LA% GPS it dr (B2 3.3V L) GPS #Hul AT HH T HLE R . [A]

19
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I AN EEX +5V 51 IBEATHNGE R, B 5] 2 51 .
51 GND A4 GPS B R 4t
HME GPS R 1 & ot ER LTI BRF 25 0 9600bps,  8bit Hdafy, TR, 1%
1EA7 1. RS-LiDAR-32 A GPS #EH 1) GPRMC M RO 8dE,  HobrvEds Uan T
$GPRMC,<1>,<25>,<3>,<4> <55 <6>,<7>,<8>,<9> <10>,<11>,<12>*hh
<1> UTC I [H]

<2> EALRES, A=HRUEN, V=RUESL

<3> 4
<4> A AER N(AEER) 3L S(FE 21 EK)
<5> &

<6> ZJEER ECRE)H W(IHE)

<7> HhfH 2

<8> Hhhifji[A]

<9> UTC HIH

<10> A ffi

<11> i, E(4)E W(PH)

<12> BAFER (A=A EEN, D=%%r, E=fi%, N=$E L)

*J& hh S E* T A7 [ A7 BT

H AT 341 GPS Bk i) GPRMC H B K BEAFEA — 315, RS-LiDAR-32 fE DIFOP
AT I GPRMC W B KJE Hr KN 86byte, A LA A #70 1113%_E (1 GPS BB A& ok )
GPRMC W 2 A&, WIRKIAHEA G DLIEEL R Robosense HiARSCH .

20
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7 RpERE

7.1 Bl
741 B P

RS-LiDAR-32 SCRF Z Rl A S, 73009 Heaml (Strongest Return) 55 JiF [\l
(Last Return) J XU [ (Dual Return) B, 241 B A XUE AT, SLls H AR 405 2
W%, Hn R P A

TG AR, AR — VRO R 23875 T R P A 2 UOHOG IR ] o S0 ik i S H
LRBEHAER. BIR— DR RSR, TR EZABAm L, PESA R . EHE ST
HAREE BRIz, e ERs LR R ATS, W all RO iR IS Bl R 22 AH I -

RS-LiDAR-32 43 e S 21 () 2 IR [BIE, AR 15046 H B5e 5 s 05 s I B f s 5 ek e
Ja PN IBIBAR o B SR e B Dy i o [ B R QD) A i S A ot ) S S Il A . AV, SRR E R i
Ja TR, ) IR A 5 i e ) L i e« SR8 B g R S et ) 2 ) i A
AR J 1A 2
VEE: FUE 2 2 AR B A Z TR BE B KT 1 K A S W a3

7.1.2 fom[Elg
MTE AT AT B — AN I, A R B
71.3 9, feo MW Elk

PO TR IE AL HIHOG KR, B B A AS[F]BE BT A7 1 T O AR R, iR [l
PIRBERAE, BERTA LU T PIAPEE R -

(1) Feo Rl AN B [T R I, 3R [m] f5 5 AT A i [ 98¢5

(2 #1952 5 J [ml B RO IR, 30% (] 5 56 [ 5 R 55— 9 ] 30

7.1.4  [AIE AR bR &

RS-LiDAR-32 Hi) BRIl Nk [0 (Strongest Return) 1, WEFH B HE L E, &
Z @A P F W% C RSView H1 1 C14. 7F DIFOP 55 300 4> byte 42 [\l i 20 ks i
Br, BT R
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A0 [P R R X R

PR AL [ 33 A X
00 R [E]
01 H R B I
02 E =1 IV

7.2 A E

%A~ RS-LIDAR-32 3T JH B 50 TAE RO, FATT S 3 i T /MG s el 1 5
Ih— AN RS ST OGP A4 9 T 98D AR R AR IR A AH EL T4, RS-LIDAR-32 4244 4H
PEBE MITRE . REREIRD> VLA AR LRI T4t

MIRE 8 5E ThE T T80 RS-LiDAR-32 72 PPS ki filt 2 (R 21, 5 2 e 4 35 52 10
RSSO, 242> RS-LiDAR-32 [R5 F AR AR i CRAFARATT 2 TRV AH O T f FE AN .
THEF AL AR IE R, T2 PPS kb fil R (55 HARRRR T .

K 12 Jy RS-LiDAR-32 B B A FIAHAL (75 2 1B, 0 EHT kR W], 24 PPS ki fih A I i,
IR BIERER) 0 BEL 135 . 270 FER SHEOE.

y y

0

4

12 RS-LiDAR-32 AS[AIFA A7 3 7 2
RSVIEW % /7% f] Tools > RS-LiDAR Information F1 21t | —> “Phase Lock” HI1Z %
BoE, ALAH T 3E B ARG A B, AN TE 2 0~359.
AHAL A E D fie 75 EEHO T IE el W B AE 600 #5 L 1200 4% (15 A 4 2.
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8 Ho=ZEU

8.1 ALPRWRES

T BB B O OO K RN S &, AT B =4S BECR, ¥
PAERR T B A FEAN R B A5 REFLAL Y T 1 RRABAR &R T xy,z 2845, W 13 Pow, AT AE
Pk AR AP

y=rcos(w)cos(a+9d);

x=rcos(w)sin(a+6);
z=rsin(w);

Horr NSEDERES, @ ONBOCKEEME, ¢ NBOCHKT IR A, SOEIE fK-T
WAL, xv y z ANARFREGE R XL YL Z Bl B AR AR,

@ FIOH] LL7E RS-LiDAR-32 4 T U %% angle.csv S04 3R L.

Z

Data Point

/ Y /
A 4
=
]
13 FHIEMLALFRFN XYZ AL by ik i
72 1: f& RS-LiDAR-32ROS &L iR# % | BASE/T T AT KT A ROS 94 FLARA, ROS FaEey X 4h2

XHEmE 13 P Y EH®, ROS TE®W Y42 X KGR 13 89X A F &,

E2: FRAHERREZXATEEMF S, &EEHKE 45.36mm,

8.2 HMAGFRAZENR

APOCHIE AT AR, 2SRRI &R B, Wil 14 fos, ZREN
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RS-LiDAR-32 F FF Mt

32 WO T IAAE R TR 43— FA R R AR 9 AN 1R BRI, R R
BN, B3RS A NIRRT, Hd = B B HE T 5 A B 1 e 2. IRk, 24
WOLTIE AR T IS AR, R 05 B4R 52 2y — RPN e, P 15 s

& 14 XZ “F1H -5 R LR

B 15 HEHHrEl
2R, AR AR A O B A AR AR A SR — LG, W 16 PosiE it A,

2 2
z X

T

Ramsisty @)’ Y gk, 4y B R, g
2 BRI My — R, alik, TSI R, B AN, XU
PR, ahll, IR, B O, TR T, 2 0 — sz

I,y K, U] — B AT 2R — By B AN R R B e B 2 R i o e

24
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x =rcos(w)cos(a +90);
y =rcos(w)sin(a +90);

z =rsin(w);

L 1

x>+ = 2" cos’(w)/sin’ (o)

|

(ytan(@))® )’

Z ¥H

16 ELfAARKRE AL X it 24 T T A%

25
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RS-LiDAR-32 I/ Tt

9 mEMABEXN

[ 17 RS-LiDAR-32 {if i & X

RS-LiDAR-32 7E 3 B J7 1] (1) £ FE Y5 Bl A& -25°~+15°, A1 FEIRIRG AR 5150 At o 4 32 DMK
s E N 32 BRIHE, 5 RS LA R RR R 17 PR 2R T SEPRBERC R,
B B R AR AR U 285 TR SR B 4 2 T T AR A

H1 T RS-LiDAR-32 HRSH 2145308 1 AB W4H, I7E MSOP & il ii 575 it A 4 .
FESAR 11 IR 12 PR CR.

TE Lem JE B8 73 #5610 B T UAS v 55 LS 40 W P 8 1) e P SRR R 11 ISR 12 I
W R BT, Semhiy 0 R A BEWE, v 1 3FRo08 B A A, AR50 5.1.2
L
£ 0.5cm 3R TIBIRA T, TAZLE A 4R B 3BT IR, 4582 A 47ER B
TES, MR 11 X ROEE 55 R B .
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RS-LiDAR-32 F P F Ml

&1 PotBEF 5 5R0CHEE AN (A AN B AR

WA P WOt S EIe TR H A WOt A EIR AT (i Fe M L vl

1 -10. 281 8

2 -6. 424 8

3 2.333 8

4 3.333 -8

5 4. 667 8

6 7. 000 -8
7 10. 333 8

8 15. 000 -8

A

9 0.333 -8
10 0. 000 —2.672
11 -0. 333 2.672
12 -0. 667 8
13 1. 667 -8
14 1. 333 —2.672
15 1.000 2.672
16 0. 667 8

17 =25. 000 -8
18 -14.638 -8
19 =7.910 -8
20 =5. 407 -8
21 -3.667 -8
22 -4. 000 —2.672
23 -4. 333 2.672
24 4. 667 8

B

25 -2.333 -8
26 —2.667 —2.672
27 -3. 000 2.672
28 -3.333 8
29 -1. 000 -8
30 -1. 333 —2.672
31 -1. 667 2.672
32 -2.000 8




RS-LiDAR-32 I/ Tt

R 12 PWotWIE 5 5WOCH I E AR (B 45T A 45)

HIE P BotHs PG T ELA BOGE KRS 5 o

1 -25. 000 -8
2 -14. 638 -8
3 =7.910 -8

-5. 407 -8
5 -3.667 -8
6 -4. 000 —2.672
7 4. 333 2.672
8 4. 667 8

B

9 -2.333 -8
10 -2.667 -2.672
11 -3. 000 2.672
12 -3. 333 8
13 -1. 000 -8
14 -1. 333 —2.672
15 -1. 667 2.672
16 -2.000 8
17 -10. 281
18 -6. 424 8
19 2.333 8
20 3.333 -8
21 4. 667 8
22 7. 000 -8
23 10. 333 8
24 15. 000 -8
25 0.333 -8 !
26 0. 000 —2.672
27 -0. 333 2.672
28 -0. 667 8
29 1. 667 -8
30 1. 333 —2.672
31 1. 000 2.672
32 0. 667 8

32 WIE M 56 K — & K T A 6] 55.5us .




RS-LiDAR-32 FI /Tt

10 5+ R{E BMEE

RS-LiDAR-32 ##i h &5 1 #e W iA Se i 35 B, RO 3R M — MR 6 S RE
JIHIERS, SV B M BAIR KR R B, AR S B X AR B i

£ RS-LiDAR-32 Hi4ii s A€ Ja i SR 5T X 18] 04 0~255, 8 ST 1A FR) S A 46 3
FETE 0~100 73 A, RO RAL, OB A 4 S IR IR S S 2 5 B A
€N 101~255, S HAE 14 SRR IR B 3 B33 255

8 )t

RO R+ R A B8 R A
Reflectivity =~ Reflectivity <100

F R ES R+ R RS
Reflectivity =100 Reflectivity~255

18 AP FRIIbRE

R B AR s RO SRS R, 7R ZEARYE MSOP A3 HH (1 5 S5 i 5 1 FH S S 34 s SC
PE—RITHEA ] . SRR E SO AT DL B & B e A v 3R A U B 3R, SRR AR
configuration_data/curves.csv. F & ] i1 5 2 30 & W 2 % RS-LIDAR-32 ROS 3K 3/ 1 i)

rawdata.cc SCFH [ calibratelntensity( ) EA%L .
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e RO BRI TR, S 9 115575 30 calibratelntensity ( ) bR #fiied J LU %,

A ) T e R A [ A o SR AR TS T S =, o B R A S 2
AR HO TR IK B Y intensity 7 ATREAT HAR A REWS AT BB A IS5 R mode 3 J73UE
BEAE FH O TR IAH H 1Y intensity,  THRFE R BOG TR K I E IR .
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11 MR

FEAE e B0 RE T, BRATT A8 21— L8 UL T ) P, AR B 2102 1 98 0 s DL )

AKX 7 1 e i 2 7 1
I 7t fifR R T 1
Interface Box ML g7~ | @  Fu A N HLYRIEF AR M & 75 IE W
ST AL BN R ® R A N YR HE AT HEL VR A i AR K (12V HE R R

M, BINHRT=3A)

Interface Box I 4L A48~
1155, GEafa T A E A
1k

152 Interface Box 5 W 4% uii I IE B 2 A )

WA LA e ® {7 Interface Box FIHi$a/~AT A2 15 1%, B\ RIS A A2
IR
® &7 Interface Box 1515 & iy (1 FE 26 /2 15 A B
WA AE A B AN W7 ® A N HYR I AR T IR

R4 A AR R AL TR A R (12V SRR
HIFTL AT =3A)

T8 46 5 T A KT SRR ARG P B A A T 4
A%

B AR IER: , ERERA
¥

o P 4 i 5 IR

BV B i ] 2% T B 75 I

i 53 A (B wireshark) A6 78 £ 2 5 A B4
i

SR PATBIs K A H A T B L D 2% ) 22 B F

R Y g I

Wireshark 7] DA 21 F 4 (H
#& RSVIEW N7 S =

K AL B ok B, I HAZ4T RSVIEW J8 3 7 K 1

A FELAN 1 TP e B8 R0 8 4% 1 1 H I ki — £

i\ RSVIEW _L[HI ] Data Port % & 1E i

ffi\ RSVIEW %2 %% H 5% BUAC & SR A7 i B A6 & AT ]
HSCERF

i\ wireshark Hific 3 B £df €92 MSOP AL £

BERAFENUR (8 5 2k

BN IR 2% FP R 75 A DB ) A ) 4% 00 o B o0 i o
BN 28 T 5 A7 AR A R 25 B0 & DL R U B K&
R 3 e JE A Ky B 28

BFOA LI PR RE NI 11k BE 2 7506 A2 2R

o B HAB I AT I 2 e %, ELE FL B A A7 R Z IR

Joik[F25 GPS K]

i\ GPS HiH il H2 4 9600bps, 8bit a7, ALK A7,
(EAIR DA

fifiik GPS i iy RS232 HL°F

A 1PPS Jikiide s HIE 26 E 1

itk GPRMC (1) NMEA ¥ B k% 20 1E

fiIN GPS # 1 Interface Box 3Lih
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ffii\ GPS BRI 147 B iR

W% B % b 28 ) TC SR I VA % H 75 (1) DHCP Zh 8 B 7E % H 25 PN 350 150 B A% TS 11
it IP N IEHA) IP
Mo BAG TR 7 A FH 0 B TR TC B SO 1E

ROS 3K 3/ & 75 i 2= W I i
A — A E I E XA
T ie e

BEHLGIE T, 2B ROS 3R ) # [ 5 G E0HEAT 73 il
s A PR S AT T RN

RSVIEW X -4 tH sl 2= il —
S5t 2k

%2 windows 10 R4 % B RSVIEW fi H 5% windows
7 AT
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FisR A X5 I U TB] 5

A1 32 LR AR A R R BT

1EREA MSOP Packet fh 1, 5 12 4~ Block, #4 block 5 —41 58 %11 32 L HOLEE,
th—~ Packet 145 12 21 5¢ B MO EIE . 32 3838 WO S L — 56 R SR 1E) 24 55.52us
PIEHI O KA RN 1.44us, 32 ZeBOL AN LKy 1.44 * 32=46.08us, 7} i 9.44us
78 e YR HE I (R

RREOET 5 data_index /& 1~32, OG5 HUT 512 sequence_index 72 1~12,
> MSOP Packet [ [EJ A2 55 1 NEOG S TR], S 7o SEAAEANEOE R (], 72045
AN PRI 18] i #5200 2 A ) 8 L

I 18] % & Time_offset 15 A3

&

Time_offset = 55.52 * (sequence_index - 1) + 2.88 * mod((data_index — 1) , 16) + 1.44*
floor(data_index / 16)
Fi B BRSO s B[] Exact_point _time:

Exact_point _time = Timestamp + Time_offset
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2 A-1 MSOP Packet F 5. [m] 357 45 O ) IO I TR A 2

channel Data Block
D
1 2 3 4 5 6 7 8 9 10 11 12

1 0.00 55.52 | 111.04 | 166.56 | 222.08 | 277.60 | 333.12 | 388.64 | 444.16 | 499.68 | 555.20 | 610.72
2 2.88 58.40 | 113.92 | 169.44 | 224.96 | 280.48 | 336.00 | 391.52 | 447.04 | 502.56 | 558.08 | 613.60
3 5.76 61.28 | 116.80 | 172.32 | 227.84 | 283.36 | 338.88 | 394.40 | 449.92 | 505.44 | 560.96 | 616.48
4 8.64 64.16 | 119.68 | 175.20 | 230.72 | 286.24 | 341.76 | 397.28 | 452.80 | 508.32 | 563.84 | 619.36
5 11.52 | 67.04 | 122.56 | 178.08 | 233.60 | 289.12 | 344.64 | 400.16 | 455.68 | 511.20 | 566.72 | 622.24
6 14.40 | 69.92 | 125.44 | 180.96 | 236.48 | 292.00 | 347.52 | 403.04 | 458.56 | 514.08 | 569.60 | 625.12
7 17.28 | 72.80 | 128.32 | 183.84 | 239.36 | 294.88 | 350.40 | 405.92 | 461.44 | 516.96 | 572.48 | 628.00
8 20.16 | 75.68 | 131.20 | 186.72 | 242.24 | 297.76 | 353.28 | 408.80 | 464.32 | 519.84 | 575.36 | 630.88
9 23.04 | 7856 | 134.08 | 189.60 | 245.12 | 300.64 | 356.16 | 411.68 | 467.20 | 522.72 | 578.24 | 633.76
10 2592 | 81.44 | 136.96 | 192.48 | 248.00 | 303.52 | 359.04 | 414.56 | 470.08 | 525.60 | 581.12 | 636.64
11 28.80 | 84.32 | 139.84 | 195.36 | 250.88 | 306.40 | 361.92 | 417.44 | 472.96 | 528.48 | 584.00 | 639.52
12 31.68 | 87.20 | 142.72 | 198.24 | 253.76 | 309.28 | 364.80 | 420.32 | 475.84 | 531.36 | 586.88 | 642.40
13 34.56 | 90.08 | 145.60 | 201.12 | 256.64 | 312.16 | 367.68 | 423.20 | 478.72 | 534.24 | 589.76 | 645.28
14 37.44 | 9296 | 148.48 | 204.00 | 259.52 | 315.04 | 370.56 | 426.08 | 481.60 | 537.12 | 592.64 | 648.16
15 40.32 | 95.84 | 151.36 | 206.88 | 262.40 | 317.92 | 373.44 | 428.96 | 484.48 | 540.00 | 595.52 | 651.04
16 4464 | 100.16 | 155.68 | 211.20 | 266.72 | 322.24 | 377.76 | 433.28 | 488.80 | 544.32 | 599.84 | 655.36
17 1.44 56.96 | 112.48 | 168.00 | 223.52 | 279.04 | 334.56 | 390.08 | 445.60 | 501.12 | 556.64 | 612.16
18 4.32 59.84 | 115.36 | 170.88 | 226.40 | 281.92 | 337.44 | 392.96 | 448.48 | 504.00 | 559.52 | 615.04
19 7.20 62.72 118.24 | 173.76 | 229.28 | 284.80 | 340.32 | 395.84 | 451.36 | 506.88 | 562.40 | 617.92
20 10.08 | 65.60 | 121.12 | 176.64 | 232.16 | 287.68 | 343.20 | 398.72 | 454.24 | 509.76 | 565.28 | 620.80
21 1296 | 68.48 | 124.00 | 179.52 | 235.04 | 290.56 | 346.08 | 401.60 | 457.12 | 512.64 | 568.16 | 623.68
22 15.84 | 71.36 | 126.88 | 182.40 | 237.92 | 293.44 | 348.96 | 404.48 | 460.00 | 515.52 | 571.04 | 626.56
23 18.72 74.24 129.76 | 185.28 | 240.80 | 296.32 | 351.84 | 407.36 | 462.88 | 518.40 | 573.92 | 629.44
24 21.60 77.12 132.64 | 188.16 | 243.68 | 299.20 | 354.72 | 410.24 | 465.76 | 521.28 | 576.80 | 632.32
25 2448 | 80.00 | 135.52 | 191.04 | 246.56 | 302.08 | 357.60 | 413.12 | 468.64 | 524.16 | 579.68 | 635.20
26 27.36 | 82.88 | 138.40 | 193.92 | 249.44 | 304.96 | 360.48 | 416.00 | 471.52 | 527.04 | 582.56 | 638.08
27 30.24 | 85.76 | 141.28 | 196.80 | 252.32 | 307.84 | 363.36 | 418.88 | 474.40 | 529.92 | 585.44 | 640.96
28 33.12 | 88.64 | 144.16 | 199.68 | 255.20 | 310.72 | 366.24 | 421.76 | 477.28 | 532.80 | 588.32 | 643.84
29 36.00 | 91.52 | 147.04 | 202.56 | 258.08 | 313.60 | 369.12 | 424.64 | 480.16 | 535.68 | 591.20 | 646.72
30 38.88 | 94.40 | 149.92 | 205.44 | 260.96 | 316.48 | 372.00 | 427.52 | 483.04 | 538.56 | 594.08 | 649.60
31 41.76 | 97.28 | 152.80 | 208.32 | 263.84 | 319.36 | 374.88 | 430.40 | 485.92 | 541.44 | 596.96 | 652.48
32 46.08 | 101.60 | 157.12 | 212.64 | 268.16 | 323.68 | 379.20 | 434.72 | 490.24 | 545.76 | 601.28 | 656.80

A.2 32 LR B AR A TR B 5

FEX R AT, &4 MSOP Packet {41, 12 4> Block. ##4™ Block Jy— /i [j 32
AN TEFOGAF B B XUEE BE S5 H, 5140 Block1 Al Block2 Sy 32 /Nidil & 5 — I i AL el
PBHE, Block 2 f o M1 Kt Block2 ki [al i s -

BRBCHOL 75 data_index 5 1~32, WOLK M 7 51l /2 sequence_index & 1~12. £k
/N MSOP Packet i [ 58 1 ANBOG AU, 8 T HHRAREANEOL AU ], 75 206 A

AN RIS T6) i 7 5200 2 ek ) 8k L
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I AR #% & Time_offset i+ AR

Time_offset = 55.52 * (floor ((sequence_index - 1) /2)) + 2.88* mod((data_index — 1) , 16)
+ 1.44 * floor(data_index / 16)

s 0 BSOS B] Exact_point _time:

Exact_point _time = Timestamp + Time_offset

K A-2 MSOP Packet H 5. [R] 3 SEAN B0 A I TR m A2 2

channel Data Block
ID
1 2 3 4 5 6 7 8 9 10 11 12

1 0.00 0.00 55.52 55.52 111.04 | 111.04 | 166.56 | 166.56 | 222.08 | 222.08 | 277.60 | 277.60
2 2.88 2.88 58.40 58.40 | 113.92 | 11392 | 169.44 | 169.44 | 224.96 | 22496 | 280.48 | 280.48
3 5.76 5.76 61.28 61.28 116.80 | 116.80 | 172.32 | 172.32 | 227.84 | 227.84 | 283.36 | 283.36
4 8.64 8.64 64.16 64.16 119.68 | 119.68 | 175.20 | 175.20 | 230.72 | 230.72 | 286.24 | 286.24
5 11.52 | 11.52 67.04 67.04 122.56 | 122.56 | 178.08 | 178.08 | 233.60 | 233.60 | 289.12 | 289.12
6 14.40 | 1440 69.92 69.92 125.44 | 12544 | 180.96 | 180.96 | 236.48 | 236.48 | 292.00 | 292.00
7 17.28 | 17.28 72.80 72.80 128.32 | 128.32 | 183.84 | 183.84 | 239.36 | 239.36 | 294.88 | 294.88
8 20.16 | 20.16 75.68 75.68 131.20 | 131.20 | 186.72 | 186.72 | 242.24 | 242.24 | 297.76 | 297.76
9 23.04 | 23.04 | 78.56 78.56 | 134.08 | 134.08 | 189.60 | 189.60 | 245.12 | 245.12 | 300.64 | 300.64
10 2592 [ 2592 81.44 81.44 136.96 | 136.96 | 192.48 | 192.48 | 248.00 | 248.00 | 303.52 | 303.52
11 28.80 | 28.80 | 84.32 8432 | 139.84 | 139.84 | 195.36 | 195.36 | 250.88 | 250.88 | 306.40 | 306.40
12 31.68 | 31.68 87.20 87.20 142.72 | 142.72 | 198.24 | 198.24 | 253.76 | 253.76 | 309.28 | 309.28
13 3456 | 34.56 [ 90.08 90.08 | 145.60 | 145.60 | 201.12 | 201.12 | 256.64 | 256.64 | 312.16 | 312.16
14 37.44 | 3744 92.96 92.96 148.48 | 148.48 | 204.00 | 204.00 | 259.52 | 259.52 | 315.04 | 315.04
15 40.32 | 40.32 95.84 95.84 151.36 | 151.36 | 206.88 | 206.88 | 262.40 | 262.40 | 317.92 | 317.92
16 44.64 | 4464 | 100.16 | 100.16 | 155.68 | 155.68 | 211.20 | 211.20 | 266.72 | 266.72 | 322.24 | 322.24
17 1.44 1.44 56.96 56.96 11248 | 11248 | 168.00 | 168.00 | 223.52 | 223.52 | 279.04 | 279.04
18 4.32 4.32 59.84 59.84 | 115.36 | 115.36 | 170.88 | 170.88 | 226.40 | 226.40 | 281.92 | 281.92
19 7.20 7.20 62.72 62.72 118.24 | 118.24 | 173.76 | 173.76 | 229.28 | 229.28 | 284.80 | 284.80
20 10.08 | 10.08 65.60 65.60 121.12 | 121.12 | 176.64 | 176.64 | 232.16 | 232.16 | 287.68 | 287.68
21 12.96 | 1296 | 68.48 68.48 | 124.00 | 124,00 | 179.52 | 179.52 | 235.04 | 235.04 | 290.56 | 290.56
22 15.84 | 15.84 71.36 71.36 126.88 | 126.88 | 182.40 | 182.40 | 237.92 | 237.92 | 293.44 | 293.44
23 18.72 | 1872 | 74.24 7424 | 129.76 | 129.76 | 185.28 | 185.28 | 240.80 | 240.80 | 296.32 | 296.32
24 21.60 | 21.60 77.12 77.12 132.64 | 132.64 | 188.16 | 188.16 | 243.68 | 243.68 | 299.20 | 299.20
25 24.48 | 2448 | 80.00 80.00 | 135.52 | 135.52 | 191.04 | 191.04 | 246.56 | 246.56 | 302.08 | 302.08
26 27.36 | 27.36 82.88 82.88 138.40 | 138.40 | 19392 | 193.92 | 249.44 | 249.44 | 304.96 | 304.96
27 30.24 | 30.24 85.76 85.76 141.28 | 141.28 | 196.80 | 196.80 | 252.32 | 252.32 | 307.84 | 307.84
28 33.12 | 33.12 88.64 88.64 144.16 | 144.16 | 199.68 | 199.68 | 255.20 | 255.20 | 310.72 | 310.72
29 36.00 | 36.00 91.52 91.52 147.04 | 147.04 | 202.56 | 202.56 | 258.08 | 258.08 | 313.60 | 313.60
30 38.88 | 38.88 [ 94.40 94.40 | 149.92 | 149.92 | 205.44 | 205.44 | 260.96 | 260.96 | 316.48 | 316.48
31 41.76 | 41.76 97.28 97.28 152.80 | 152.80 | 208.32 | 208.32 | 263.84 | 263.84 | 319.36 | 319.36
32 46.08 | 46.08 | 101.60 | 101.60 | 157.12 | 157.12 | 212.64 | 212.64 | 268.16 | 268.16 | 323.68 | 323.68

E: BHEAEYH, mod: WRIEHE; floor: A FHUEIZH
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P B &8 aE L

BEAE A ANTE 5 S5 PSR E SCRME BAIE S BT R e A AT R

B.1 HHL##E (MOT_SPD)

YR FRE (3L 2bytes)

e bytel | byte2

ikt MOT_SPD

A A UL

(1) ABFA725% F LARC B HOALR ) R B LK

(2) B A7 it R A R oA 2

(3) BCEFEDIRAT

(byte1==0x04) && (byte2==0xB0) : #%i# 1200rpm, K% jEs:;

(byte1==0x02) && (byte2==0x58) : %i# 600rpm, %N jiEs:;

(byte1==0x01) && (byte2==0x2C) : #%i% 300rpm, Jifif} %l jiEss;
Mg B HAh A, BB S 0.

B.2 LAXM (ETH)

UK 728 (3t 22bytes)

e bytel | byte2 | byte3 | byte4 byte5 | byte6 byte7 | byte8
Tk LIDAR_IP DEST_PC_IP

g byt | bytel0 | bytell | bytel2 | bytel3 | bytel4 | bytels | bytel6
B) i MAC_ADDR portl
I byte17 | bytel8 | byte19 | byte20 | byte2l | byte22 |

Thie port2 port3 port4

TAE A UL -
(1) LIDAR_IP J/y LiDAR (195 IP #ihik, /54 4byte
(2) DEST_PC_IP N H &) PC ) IP #ulik, ¥ 4byte
(3) MAC_ADDR A LiDAR [f] MAC ik
(4) portl~port4 i 1515 £, portl y MSOP 2 LiDAR % tH ()3 1145, port2 N
MSOP 11 H ) PC $24itii 115, port3 iy DIFOP 4, LiDAR %t I A #th i 1, port4 Jy DIFOP

L HK PC i L5 . BRI portl Fl port2 % B AHIF, port3 Al portd ¥ B AHIH

36




RS-LiDAR-32 FI /Tt

B.3FOV i%& (FOV_SET)

FOV &8 (3t 4bytes)

] bytel | byte2 byte3 byte4
YiRE FOV_START FOV_END
AR UL :

B W% A OB KT f B L, FOV_START Al FOV_END %35 Fl 0~36000,
XTI FE 0~360°, {777 RO K. Helll: bytel=0x5d, byte2=0xc0, byte3=0x1f,
byte4=0x40, -

FOV_START = 93*256+192=24000

FOV_END = 31*256+64=8000
WA R B A LR R 7K 1 REVE T Dy 240.00°~80.00°
FE: DL byte S EH S HERIRE AL Tk G AT 5

B.4 HHLBIAHFEAL(MOT_PHASE)

RHLBRE A4S (3t 2bytes)

75 bytel | byte2
Yihk MOT_PHASE
A7 A UL

W B LR BB ) e B AR A, TR GPS Y PPS Bk s, # {8 75 [ 0~360, Xif
MNARE 0~360° , fEfig 7 ROV Kimi, tbin: byte1=0x01. byte2=0x0e, NS4
fifE A 1*256 + 14=270;

TE: BLE byte . l+7NBE il 2t il Ja BEAT 15

B.5 EAMR[E R4 (TOP_FRM)

R E A (3t Sbytes)

7 bytel | byt |  byte3 byted bytes
ViR TOP_FRM
AR UL :

RS 5 ERE SO S0 B, XS RSEFR AR -
[l AR AT T6R23VE_T6_A
iR A S 06 23 06 06 A0
HI B4 AR 59 0x06230606A0
FRA S H bR “_A” R RATFEFFIRAS Application, “_F” 3&on 1) #aUFE 7 iRAS Factory .
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B.6 JEAR [E iR 4= (BOT_FRM)

JEAE R4 (3% Sbytes)

7 bytel | byt |  byte3 byted bytes
Tiag BOT_FRM

TFAF AU -

ZIRA S G SRS SRR, R R SE R U -

[l SR A S B7TR14V4_T1_F

ittt A S 07 14 04 01 FO

R B30 A5 . 0x07140401F0
WA S HbRId “_A” R N HEEF RA Application, “_F” /s T U7 A Factory .

B.7 %5 (SN)

F35 %7 (3t 6bytes)

75 1byte | 2byte | 3byte | 4byte | Sbyte 6byte
g SN
AP mac Mk, LA 16 @k 3 6bytes BE fam W& P AT
B.8 EArHlIKENFH A (S (SOFTWARE_VER)
AR B AT FA (3t 2bytes)
] bytel | byte2
g SOFTWARE_VER
SRR RINTEN [ E S EY SR
B.9 KJ[E (UTC_TIME)
B A& 47%% (3£ 10bytes)
e bytel byte2 byte3 byte4 byte5 byte6 byte7 byte8
Uife year month day hour min sec ms
e byte9 byte10
Uife us
AT U B -
1) year
regname: set_year
5 bit7 |  bit6 bit5 bit4 bit3 bitz | bitl |  bit
Uife set_year[7:0]: ¥ 0~255 Xf % 2000~2255 year
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2) month
reg name: set_month
5 bit7 bit6 bit5 bit4 bit3 bit2 bit1 | bit0
ThRe TR TR TRE TR set_month[3:0]: 1~12 month
3) day
reg name: set_day
Fe bit7 bit6 bit5 bit4 bit3 bit2 bitl |  bit
Uik fREE fREE fREE set_day[4:0]: 1~31 day
4)  hour
reg name: set_hour
K bit7 bit6 bit5 bit4 bit3 bit2 bitl |  bit
Uife e TR 1R set_hour[4:0]: 0~23 hour
5) min
reg name: set_min
5 bit7 bit6 bit5 bit4 bit3 bit2 bit1 | bit0
Uik frE N set_min[5:0]: 0~59 min
6) sec
reg name: set_sec
Fe bit7 bit6 bit5 bit4 bit3 bit2 bitl |  bit
Uik fREE e set_sec[5:0]: 0~59 sec
7) ms
reg name: set_ms
e bit15 bit14 bit13 bit12 bit11 bit10 bity | bitg
ke TRER TR e TR e TR e TRE Nz ms[9:8]
e bit7 bit6 bit5 bit4 bit3 bit2 bit1 | bit0
B) i set_ms[7:0]
7E: set_ms[9:01{HVE[l: 0~999
8) us
reg name: set_us
e bit15 bit14 bit13 bit12 bit11 bit10 bit9 | bit8
Tyke TR TR TR TR IRE TR us[9:8]
e bit7 bit6 bit5 bit4 bit3 bit2 bitl | bito
B%) i set_us[7:0]
7E: set_us[9:0]{EuF: 0~999
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B.10 iZfTIR%E (STATUS)

BITREFTFALIE 18bytes

55 bytel | byte2 | byte3 byte4 byte5 | byte6 byte7 | byte8
Uike Idat1_reg Idat2_reg Vdat_12V_reg
e byte9 | bytel0 | bytell | bytel2 | bytel3 | bytel4 | bytels | bytel6
Thie Vdat_12V_M_reg Vdat_5V_reg Vdat_3V3_reg Vdat_2V5_reg
e 17byte | 18byte | |
ke Vdat_1V2_reg

A AT A UL B :

(1) Idat, 4% 2 BEHE, Hb Idatl 2 gt i, Idat2 & E i .

% L IRAE A /N 3byte 2k, ZH K Idat_reg[23:0]. FLrhfmifz Idat_reg[23]/2 5 5 hp &AL,

Idat_reg[23] = 1 N, Idat_reg[23]=0 NIE{H. Idat_reg[22:0]%} N H{E KN, LSB A

1uA,

Idat=

B AR
{ Idat reg[22:0]--------

—Idat_reg[22:0]-+-- (Idat_reg[23] =1)

(Idat_reg[23] =0)

Idat= {

—Idat_reg[22:0]

Ebfm, 4 bytel = 0x8C, byte2 = 0xD5, byte3 = 0x00 i, SEZBRHEIAE:

Idat = -Idat_reg[22:0] = -0x0CD500 uA = -840960uA~-841mA
(2) Vdat, 045 6 PEHLRAE, BE%FEIRE /N 2byte 40%, 41/% Vdat_reg[15:0]. H:
HiEr 4 f7 Vdat_reg[15:12) %3 2. Vdat_reg[11:0]%F B HJEAE A /DN, & v B i+ A R

F

Vdat 12V =Vdat 12V reg[11:0]/409 = 2.5+ 12
Vdat 12V.M = Vdat 12V.M reg[11:0]/409 = 2.5+ 12

Vdat 5V = Vdat5V reg[11:0]/409% « 2.5+ 4

Vdat 3V3=Vdat 3V3reg[11:0]/409 = 2.5+ 2

Vdat 2V5 = Vdat 2V5r e g[11:0] /4096 = 2.5+ 2

Vdat 1V2 =Vdat 1V2r e g[11:0]/4096 = 2.5+ 2
PA B TR A B R A 2 REE (V) .

40

Idat reg[22:0]---

- (Idat_reg[23] = 0)

----- (Idat_reg[23] = 1)
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B.11 #[&i2¥; (FALT_DIGS)

HIRZHT A4 (3t 40bytes)

5 bytel | byte2 | byte3 | byte4 | byte5 | byte6 | byte7 | byte8
fie RN

byt | bytel0 | bytell | bytel2 | bytel3 | bytel4 | bytels | bytel6

ol

PR A cksum_st manc_errl manc_err2 gps_st

bytel7 | bytel18 byte19 byte20 byte21 byte22 byte23 byte24

[VEV'U

temperaturel temperature?2 temperature3 temperature4
5 byte25 | byte26 byte27 | byte28 byte29 | byte30 byte31 byte32
e temperature 5 PN B 1R e r_rpm1l
5 byte33 byte34 byte35 | byte36 | byte37 | byte38 byte39 byte40
ik r_rpm2 DA I
oxet LR

(1)FR+ byte11 ) cksum_st /& 5:H EEPROM F R BR KM 1R 56 A ) B IR S FE
cksum=0x00 K7~ BAAME E % 7T, cksum=0x01 R/~ PUAME{E A IEH , FPGA W iR
PURL IE

(2) manc_errl M manc_err2 M T+ S EGEE E M A RILAE, manc_errl HTiHHE
1bit A%, manc_err2 AT 1HHE 2bit IWILE, RIDEFTFEARWT:

manc_errl_per = manc_err1/65536 * 100%
manc_err2_per = manc_err2/65536 * 100%
manc_errl_per B manc_err2_per N 0 K}, 285 & H{E L .

(3) temperaturel, temperature2 f&JiCHRIEE, temperature3, temperature4 J& it
. WA K/ H 2byte 4, 1 3 i temperature[2:0] F 4 L= X . & 13 fiL
temperature[15:3] & & £ H R fH , H o &% & AL temperature[15] & £ 5 #5 & i,
temperature[15] = 0 N IFE, temperature[15] =1 Nffili. A HEAR:

temperature[15:3] /16 (temperature[15] = 0)

temperaturel 4 = {— ((8192 — temperature[15:3])/16) (temperature[15] = 1)

Temperature5 A& IR . BEE K/NH 2byte 2%, & 4 {7 temperature[15:12] %45 76

B M. K 12 7 temperature[11:0]/2& & %A %E, H & &7 temperature[11]/2 fF 55 &

fii, temperature[11]=1 N%1{E, temperature[11]=0 NIEH. EEITHEAR:

temperature[11:0]/4 (temperature[11] = 0)

temperatures = { — (4096 — temperature[11:0])/4 (temperature[11] = 1)

(4) bytel6 +& GPS 15 THINIRAZF A7 a5 gps_st, XA A7 anfli ] 3 AN ELRefz, M TR

A FIFEA PPS {55 1 GPRMC {5 52 A R AN 73 24 5T RS AT B )2 i A b it
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K )ik &

[F4%3] UTC. bit f75E X

GPS fE 5HINIRAE F /728 GPS_ST

EUSEsy Thke RSMH AR 1A
bit0 PPS Fr: 0 PPS {55 L4k
PPS_LOCK 1 PPS {55 H &
bit1 GPRMC Fri: 0 GPRMC 155 £
GPRMC_LOCK 1 GPRMC {5 545 %%
bit2 UTC 85E b i 0 LiDAR P &8 7] 45 A1 UTC e ) 33k 47 ) 20
UTC_LOCK 1 LiDAR P4 &8I (8] IEZE AT UTC W A] 33847 [F] 25
bit3~bit7 Tied X N/A

(5) HIHLASZI #5548, i byte32 fil byte33 BN F 40k, HHEARUIT:

HLHLSEI 5 =

(256 *r_rpm1 + r_rpm2) =6

(6) HAhH 17 %2 PRl 3 47 3

B.12 GPRMC 45 &.-ASCII Fg¥ 4 28 7Y

GPRMC £ ¥a B TR 1 86 A7, MR #2211 GPS #H i i GPRMC 1 B K H &
N 5¢ FE A4 P 30 i GPRMC T8 ., 7T LL ASCIT B HEAT AT A 5 .

B.13 EHAKH#: (COR_VERT_ANG)

BRHMARMEFFEE (3t 48bytes)

F5 bytel | byte2 | byte3 byte4 | byte5 | byte6 byte7 | byte8 | byte9
iR 1BEEEAE 2 JHiEEE A 3 Wi A
5 | bytelo | bytell | bytel2 | bytel3 | bytel4 | bytels | bytel6 | bytel7 | bytels
Uik 4 3@IE I E A 5 JHiE I A WEREMAE
5 | bytel9 | byte20 | byte2l | byte22 | byte23 | byte24 | byte25 | byte26 | byte27
Uik 7 JHIE A 8 i I A WEREMAE
e byte28 | byte29 | byte30 byte31 | byte32 | byte33 | byte34 | byte35 | byte36
Uik BIEEEAE JHIE A JHIE A
e byte37 | byte38 | byte39 byte40 | byte41 | byte42 | byte43 | byte44 | byte45
Uik BIEEEAE IS A IS A
e byte46 | byte47 | byte48 | byte49 | byte50 | byte51 | byte52 | byte53 | byte54
Uik BIEEEAE JHIEE A IS A
% | bytess | byteS6 | byte57 | byte58 | byte59 | byte60 | byte61 | byte62 | byte63
ke T A 20 B EE M 21 B EE M
¥ | byte64 | byte65 | byte66 | byte67 | byte68 | byte69 | byte70 | byte71 | byte72
e T A 23 B EEME 24 BB EE M
5 | byte73 | byte74 | byte75 | byte76 | byte77 | byte78 | byte79 | byte80 | bytes
Uik 25 i I E A 26 JHiEEE A 27 JWiE I E A
e byte82 | byte83 | byte84 | byte85 | byte86 | byte87 | byte88 | byte89 | byte90
Uik BIEEEAE HIE A JHIE A
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7% | byte91 | byte92 | byte93 | byte9s | byte9s | bytegs | |

e 31 EIEEEMAE 32 EREEMAY

TR UL -

(1) AR NX S NIES, FANEIE 9 E B A H 3 4 byte 4L, 5 14 byte
FORIES, H5 2 I3 3 4 byte LU E IO, (AR Kot

(2)  FRIEFMIEE 14 byte JE M 0x00 WEE T EH M ENIE, BYEH 0x01 NiE
18 3 BN

(3)  FHfHI A LB LSB=0.001;

(4) Bl iE 1 % 77 2% 1 1E A bytel=0x01, byte2=0x28 #% e i + ik 1 40,
byte3=0x29 4 p+HEH] 41, NHELE 1 9T B A EE -

- (40*%256+41) *0.001=-10.281

B.14 /K P AR #E (COR_HOR_ANG)

THARMET Fas (3 48bytes)

Ads bytel | byte2 | byte3 byte4 | byte5 | byte6 byte7 | byte8 | byte9
Thae 1 3BIE K i F8 2 2 A K F2 L 3 W IE KPR M
e byte10 | bytell | byte12 byte13 | byte14 | bytel5 | bytel6 | bytel7 | byte18
Thae 4 TEIE KPS H L 5 JBEIE KT i F2 L 6 S IE KPR M
e byte19 | byte20 | byte21 byte22 | byte23 | byte24 | byte25 | byte26 | byte27
Thg 7 SBIE K i 8 IHIE K- i F2 1 2 9 IHIE K F-m A2
e byte28 | byte29 | byte30 byte31 | byte32 | byte33 | byte34 | byte35 | byte36
it 10 I K hES i 11 AP S B 12 3 KPS B
7% | byte37 | byte38 | byte39 | byte40 | byte41 | byte42 | byted3 | byteds | bytess
Theg 13 JEIE KPS A 14 JBIEKP W F A L 15 JEIE K-V A L
5 | byte46 | byte7 | byte48 | byte49 | byte50 | byteS1 | byte52 | bytes3 | bytesd
Theg 16 JEIE KV ts i L 17 JBIEKP W F A L 18 JBIE KV Fs A L
5 | byteSs | byteS6 | byte57 | byte58 | byte59 | byte60 | byte61 | byte62 | byte63
Thag 19 MIE KPR HS F 20 JEIE K i F2 L 21 EIE K i B2 L
e byte64 | byte65 | byte66 | byte67 | byte68 | byte69 | byte70 | byte71 | byte72
Thae 22 JEIE KPS f 23 EIE KT F8 L 24 JEIE KT F8 L
e byte73 | byte74 | byte75 byte76 | byte77 | byte78 | byte79 | byte80 | byte81
Thg 25 JEIE KPS 26 JHIE KT i F8 L 27 BIE KT i B8 L
e byte82 | byte83 | byte84 | byte85 | byte86 | byte87 | byte88 | byte89 | byte90
it 28 WK L 29 I TE KV L 30 3 AP S A L
7% | byte91 | byte92 | byte93 | byte9s | byte9s | bytegs | |

it 31 KPS L 32 I AT WS B
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TFAF AR UL

(D

(2)

(3)
(4)

A X 73 9IE S, AN IEIE R K-Fm A M B2 i 3 4> byte 4R, Hopsg 14
byte F/nEF, 25 2 FIZE 3 A byte 4L MH, A7 R Ko =

RN IETHI 14 byte J&TEJy 0x00 W@ IE K-V k2 M OV IE, J&TE 0x01
DU 3E8 3 7K T B2 £ RE N A7

A4 1 £ FEAAL ) LBS=0.001;

B UniE I 10 %5 47 2% 1918 N byte1=0x01, byte2=0x0A #% # /i + i %) 10,
byte3=0x70 4 i+ 112, MIEIE 10 7K mHs M R

- (10*256+112) *0.001=-2.672
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fy% C RSView

FEAR B 5% ot JE s e 5 ) RSView SRE. AIHAL . CRAFAI[E] RS-LiDAR-32 ¥#f
Xt T M RS-LiDAR-32 19 2 IR a6 44, vy Afs ] — 284 3% TR 2480, 6140 Wireshark A1
tep-dump. {EFF AT AALIX S 80HE , 4 1 RSView J& 5 S 75 5 SEBL i 7 3K, A VAt
(BIRA N RSView3.1.5,

C.1 BAFThRE

RSView $i it 44 RS-LiDAR-32 4 #EAT S WAL I DI e - RSView 1 RE[RI LR A7 peap
SRR IR, (& IE AN RE S RF.peapng # K SCA

RSView K RS-LiDAR-32 75 $II 2 28 Il 5 f /s N — A i BIRENE SCRFZ i [ 8 Bk
BREERE, Bl EEL BEE . AP A ERIBOCAR T S . BT R R AR R S R
£ CSV #30, RSView3.1.3 MIRAAN SC 4 5t LAS 4% XM HH . 2 A AR A AN SCRE 5
LAS. XYZ 8(# PLY #3301

RSView Frtl & i) Zhfe:
® EI UKW S R s
® CKESTHHHRIC T RAF Y PCAP SUAF
® Jidk[¥) PCAP SCIFHR[AIK
® RFEIZAIHAKEEIA, BIanFEEs. W), /KF f B 5%
o JHFMK BN MBI
o A aBUET AN CSV R
o JEETA
© N [ JECH A 1) 8 2 R R

® I NERFFajK RS-LiDAR-32 HAN R4 TR

|

7

® HEI
C.2 ‘&3 RSView

RSView F) % %% 0452 3 Windows Y 64 (L #AE RS0, 2238 5 AN 75 22 285 HoAth (s 4 1
RS-LiDAR-32 {12 B ) U £ 4 RSView [ % %% f1 RSView_X.X.X_Setup.exe.

A LA Robosense H'E M (http://www.robosense.cn/resource) _F il 3 & i A< RSView
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LA o R AT IR AR PR IR A VAT, 2358 5 A S AR AR GE Ty 3. 2R AR AN
A LU ST

C.3 WEMHK

S 5 B IRFIEIA L) I BE R R B TP Huhl, KERGARE N BT
HALPIERAS 1P f bl 192.168.1.102, T MRS A 255.255.255.0 . L AME 75 24 - RSView
BT LB KBS BB = 2 A R AR L

C.4 "I EE

1. RS-LiDAR-32 i HL R, I FH 0 2 1 e o i 425
2. ABEAE A PR ABLRIZ 4T 4T T RSView 4

3. s File > Open Jf Hi%#% Sensor Stream (| C-1)

RSView
File ] '.l'.o.ols ][e]...p
Open - Capture File
Recent Files % Sensor Stream
Save As LS Choose Calibration File

~ Ezport To EiwiViewer

Save Screenshot

Close Data Ctrlil

Exit

B C-1 FTFF RSView i 4R S ow

4. {E#£ H ¥ Sensor Configuration & [+, BRI\ —/ 4y 4 4 RSlidar16CorrectionFile
MERIESHHEF, HE1E Add BIWLHEEN NS HE R, SUERENAsBTRESR
Filo SRR B SR SCHFICARSE A OK (B C-2). MRS B SRR S I B AR R AN R
TR CEE P CERF, JEH TR RSO R T R EA =A CSV R S F (angle.csy,
ChannelNum.csv, curves.csv) . &1 LA7E RS-LiDAR-32 )62 BT (1) U 45 5L 1 3 20 5% B 1) i
B Ak configuration_data. Bo & AT A BURAEA VA T CFRF. (2019 429 HZ A
¥ 8 % BLEAE BRI S BRIRD
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Configuration
11th
| 161182100257

|_Add Eemove | Clear
Senzor Fosition Type of Lidar Intenzity

I 0002 Fiteh : ES16
T 0002 Rell : Mode?

| BSBpearl Madel

| 0K || Cancel

C-2 1E#% RS-LiDAR-32 31 & SC

5. RSView JTf &< SEiy RAERHHE (K C-3). mILUE fidy Play #8081, # mith—k

A LAGREE B

Kl C-3 Hikm=Hds

C.5 {#7% RS-LiDAR-32 ¥iE 5 PCAP &,

1. ESEI B HAR I S Record 1241 (B C-4).

B C-4 RSView {fE4%40
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2. fE# 1 11) Choose Output File X[ iFHE S, WEHEFH ERF WA AMRE ML )G, S
“ORAF (S) 7 HZHI(K C-5). RSView FEIFUGR AR WS N HAR peap SCIFH. (VER:
RS-LiDAR-32 #7748 K E%E, BEEICEM K, Hibs pcap XK &4 K. Ktk
IFHC RS ORAF 2] HDD B SSD o, Ifi AN ORAF BB 1 USB BE# B I I 2% £RAF) o

AR (E)

IHEE(N): 2017-07-29-11-43-02-RS-16-Data.pcap

Choose Output File =
Q,\/,v‘,‘é“ » EHL » win7 (T » - |¢, | | EE win7 (C) ol
|| TS - @
B - E=® i = Kb *
= BF PerfLogs 1=
| Program Files
@ RETE 1 ) Program Files (xB6)
& =5 || Python27
= Qt
18 temp
&, win7 (C) Tllemp
window =

FEZRT): | peap (“.pcap)

~ faErits | FES) | |

K C-5 RSView RAEXT G HE

3. EA Record #4145 1EARAF peap #3k .

C.6 [EIK pcap $iiE

A LAfSE A RSView Xf RS-LiDAR-32 {RA7 [ %i#s peap SCHFEAT e Mt . 8 m] LA
F Play %41 25 7% il sk i B A thoml DU BRI % 3D A = B5di b i — 35843

SREFTITRAR AT 20T o peap SCAF I RAF A2 AN AT LLA A 3L

1. siifi File > Open 3 Hi%$ Capture File.
RSView
File | Tools Help
Open "~ Capture File
Recent Files # Sensor Stream
Save As | © Choose Calibration File

w Export To KiwiViewer

Save Screenshot
Close Data

Exit

C-6 #JF pcap i3k 3L #F

2. #H Open File X iEHE, HEFHFE—ACHKM pcap SCAIFH S H “4TFF (0) 7 24l
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Open File > . . Iéj

Lo > HEHL » RS (E) |4l Z=ztm=m 2

mR v FEfE =~x 0 @
2345 - = i A e Fih

& TE

m=E

I SEsEmeE

I back_lidaer 2018/6/12 E5E...

1]
=
7
.
8
| a
B
=3
-
¥
o
p
[t

O WPS o

- E G |
B sz
= B8R
B

==

1

SHEN): back_lidaer - ISuppoﬁed Files (minp "t v]

[ 770 || = |

C-7 #T7F pcap i1

3. 7 Sensor Configuration X 1EHE, ¥ N Jfi% £ IEA 1) RS-LiDAR-32 HC & SCAFJF sl
OK %4 .

4. sy Play $4 T DL SO B 50 . A Scrub 1 3h T EL A S 18 3 T L& R AR R
[FA7 B M, b T H AN Record #2418 [ — A THA= AN (B C-8)

KB Do G

P C-8 RSView Play #4411 f1 Scrub &3 T &

5. N TAF B N BARR 734, 16 35— WU B O ER (1 804k IF B 57 Spreadsheet 4% (1€ C-9).
— ML R & BoRTE R P A, TERPES T X —WTA s .

' RSView l

File Tools Help

—
.=

| Spreadsheet |

K C-9 RSView 4% T A

6. A ARG ARSI 9, BUE HE A5 2 N B
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-Data Point Data -

Foint I Points adjustedtime azimuth distance m intenszity laser_id timestamp
1] 739 1. 776" 995301570, 000 993 10. 380 5 i1 998301570
1 752 1.814 998301620, 000 1011 10. 415 B 11 998301620
2 753 1.520 995301623, 000 10z 10. 390 25 12 995301623
3 754 1,529 995301626, 000 1013 10,390 13 13 995301626
4 TBE 1. 546" 9E53016T0. 000 1029 10. 415 & i1 998301670
15 76T 1.861 998301673, 000 1030 10. 440 25 12 998301673
B TBE 1.861 995301676, 000 1031 10. 390 13 13 YIEI0L6TE
T -E] 1,871 995301679, 000 103z 10,410 33 14 995301679
g TE0 1,877 995301720, 000 1047 10. 410 & i1 998301720
9 781 1.893 998301723, 000 1048 10. 440 25 12 998301723
10 782 1. 596 995301726, 000 1049 10. 405 13 13 995301726
11 733 1. 906+ 995301729, 000 1050 10. 425 40 14 995301729

& C-10 RSView £A% BN

7. Riifi Spreadsheet H1[1) Show only selected elements, 1 L7521 FT % 5 s 5 N i

MR LR, BB AT (E C-11).

S ELLLE

Foint ID Faints adjustedtime arimuth distance m intensil Show only selected elements. pstamp
1] 739 i 995301570, 000 933 10. 380 5 11 995301570
1 752 1,814 5301620, 000 1011 10. 415 & 11 995301620

& C-11 RSView show only elements T. &

8. i1 Select All Points " H, XfH1S &M RARER— N EdE e F T H (B C-12) .

& v I «

File Tools Help

Select 411 Foints |

K C-12 RSView Select All Points . H.

9. 7£ 3D FdE B n A, A bR — M7 TR — S8 N, X S R 2 1
Spreadsheet #1E#¢, FF HAEEH SR (A C-13).
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Data - I Point Data - EENENNSNE 3 [FRo )k

Point I Ponts sdjustedtine azasatl b distence. sntenzity
=3 49005+ 241511245.000 5373 &0. 770 25 1
== 49024 2841511285.000 5981 0.6 25 1
(3 43 007 2841511345.000 5408 80,470 £ 1
=3 49 005+ 2541511395,000 5427 0,30 28 1
011 49 00 ZBAIS11445,000 5445 £0.200 28 1
o1 40,013 ZRAISII405,000 S4SE 80,070 28 1

o1 49 014 saez 59930 20 1
e 49008+ 5368 60.790 28 1
Tel0 49,016 5366 00,660 29 1
ez 49,015+ 5404 60,520 29 1
a13 4013 ZE4ISIZE42.000 5422 &0.330 30 1
04 a3 00 2541512892.000 5440 80,230 2 1

2 T 9014 2341512042.000 5458 £0.110 a2 1

£ 49017 2341512902.000  SATS. 58, 880 3 1

14 8175 57,851 2841513390,000 5807 09,600 5 1
99 057 27,000 5364 60,870 30

5 9 045 2841514139,000 5388 80,840 25 1
17 Bea0 a3 043 Z31514177,000 5352 80,720 3

18 Bea3 49 29 231514182.000 5388 &0 630 25 1
19 01 400010 ZB41514227,000  §400 £0.570 £

20 8710 49 020+ 241514290.000 5404 60.530 21 1
31 49,030 2B41514277.000 5417 80 430 33

22 e .00 2541514208.000 5421 80, 400 21 1
23 8781 a5 e 215147000 5475 0,290 n

24 &71I0 4 017 41514332, 000 543 #0280 28 1
e 25 876 .03 ZRAISATT.O00  S4S3 80,180 2

K C-13 RSView List Selected Points T. E

10. F T35 FR ) s &R BT LB T Spreadsheet>Show only selected elements>Output CSV data

PRAT
C.7 RS-LiDAR-32 T.J FHZEME

RSView 2 fit 7R B T UCWP #C f1 T H A LA R EC B RS-LiDAR-32 L) [l {4 ¥ i 1 4%
. LUK SH. BRI H, ml ik A B A

fEWMC# RS-LiDAR-32 L) [ IS HUI %, 7 29 S5 fRIE RS-LiDAR-32 B{& D4 IE
WP BT LSS B R 3l . £ Tools > RS-LiDAR Information, £33 & & 1. 55

A O Get ¥4, £ 5o~ 2407 RS-LiDAR-32 N #1415 & iS4k .
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MSOP Port: DIFOP Port:

Mac: 0o = 2 : la

Serial Number: 161190504877

Return Mode: Azimuth Calibration(Deg):

FOV(Deg): ; to 360,00
Phase Lock: Rotation Speed: 800
Bot. FW. Version: 03

Top FW. Version:

Year: 17

Hour: 1

|  Get | |SetLiDAR|

K C-14 BHEIEN S

BRATAT LAAE B 1 & e AT AR B 5 IS 80 (LT ME g 228451, A B e 5 b DL SR
WoNME) , #RJ5 S Set LIDAR. #2755, 3K Get &F& RS-LiDAR Information #fiih &

HRB LU

MSOP Port: DIFOP Port:

Mac: 0o & = la

Serial Number: 161190504377

Return Mode: Azimuth Calibration(Deg):
FOV(Deg): to
Phase Lock: Rotation Speed:
Bot. FW. Version: 03

Top F'W._ Version:

Year: 17

Hour: 1

| Get |[setLiDAR|

Bl C-15 BB FHL NS H
1 TS E e A R T, —E A EK H LIDAR, 421 p LIDAR PR S #UR A7
B
¥ 2: WHRET RS-LIDAR-32 T.) [ {4 ) MSOP Port 5¢ DIFOP Port Z:%{, H#7i%#:
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B A% 1A s i 7 B AR S C.8 17 B RSView 1) Data Port.
C.8 Bt B RSView Data Port

RS-LiDAR-32 R\ MSOP it 15 /& 6699, ERiNf) DIFOP i[5 /& 7788, WIRTE C.7
B T IX 2 AN S e HAb 7 BT RS-LIDAR-32 [y 15, FRATT ) 75 22 25 37 1 8
RSView 3k HUEHE 1) Data Port Jy & o) i H 5, 75 PR AN 2 8dls B W iR AN N iE
RS-LiDAR-32 [1) MSOP ¥ I f1 DIFOP %ij [, ] DUEH 4 B MG f5, {8 4 Wireshark 3 {4
LA A LiDAR #5411 Dst Port.

A5 Tools > Data Port, #ii A& 25 ) RS-LiDAR-32 MSOP Port #1 DIFOP Port, #RJ& 5

7 Set Data Port.

@ Data Port Setting |1_”_£__|
Current MSOP Port: Current DIFOP Port:
New MSOP Port: Q9ER New DIFOP Port: G877

[SE:E Data Port

K C-17 & 15
C.9 TELBEMHFHK
BB e RIE RS-LiDAR-32 B4 LA IEH &, Hal LLIER BoR S = f3RE c.8 v L)~

ERE NSNS
& Tools > Online Update, W1 C-18 Fr7x s, AT LA 35 S A [l 44 B8 3 A0 e Al ] 44

Top Board Update

Eoattom Board Update

Config Update

K C-18 {ELETH2K

%40, sidi Bottom Board Update Jm £ 3 H ) & I e £ -4 i & f.rpd [ 1R 3CAF, 2R
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Ja R AT AT, PR AR A AR T B TR AR & fp sk — B a], TH5E a2 BoR
“Online Update Successful”

#¥: Config Updata iEITAT H .

. @ Select Update File
@Q,| | « PLIRSLIDARIG »firmware » B7R14 ~ 4 || m=57m14 2|
|m oy FETEE =~ 0 @

m|=F & =5 ‘ Eid]
Sl SRR ) popiavn a2 M2 150Kjic JIC 37
| [ B7R14v2 A2 M2 150K L132jic JIC 3o
= T[] B7R14V3_A2_M2_120K jic JIC 3ol
L5 Subversion | | B7R14V2 A2 M2 150K.jic 2018/2/3 18:08 JIC Zris
B s = Yois/era 1220 ReD o
= Es || B7R14V7_Fjic 2018/6/4 12:24  JIC 0
B
o BETE
& BER
™
&, s ()
Ca FHEE (D2
aFEE . ‘ r
STHEN): BTR14VT_Arpd - [l Files () -
[ 7o | | = |

K] C-19 EFEF I 14

:@ information X
|@ Online update successful!

OK

B C-20 W KT
C.10 #HfEiZH

7 ZH JeRIIE RS-LiDAR-32 s CA IR W ER, JFn] LLIEH B iz fIZREL €8 th L)
EEE S

& i Tools > Fault Diagnosis, 3 H #5112 Wi & 1. fUid5 Start 3% 1 ] DL 45 %
RS-LiDAR-32 JSERPIRA 4%, BEA MR, Bk, WA, Bl R E%E .
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Operation Status Fault Diagnosis

Current Temperature Checkout Bit

Idatl: 822.016 temperaturel: 444375 sty E

Tdat2: 494.528 temperamre2: 43 6875
Voltage temperanre3: 515 Error Rate
Vdat_12V: 10.4956 temperatured: 61.8125 manc_errl_per:
Vdat 12V _M: 11.6382 temperature5: 41.75 manc_err?_per:

[t s\ 4.97559 Time Synchronization

Vdat_3V3: 3.30811 ok 505 Echa Euos
- o a uart_baud_error: 00

LR 2:4963:4 PPS: pps not locked

; . p lock
7 i)
Vs D 1.19873 GPRMC: gprme not locked

Time: not synchronized

Start Listen!

| Start |[ Stop || Clear |

K C-21 WfEis b
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Fft % D RS-LiDAR-32 ROS Package

A B 53K 156 B 40 4AT 48 B Ubuntu+ROS 3R EUFI AT 484k RS-LiDAR-32 (%45

D.1 &EHH

1. F#JF%3% Ubunutu 16.04 #:1F R4 .
2. WRIEHEEE (http://wikiros.org/kinetic/Installation) %% 3f:J13% ROS kinetic A IhfE .
3. TN # I %% libpcap-dev.

D.2 %#i¥ RS-LiDAR-32 ROS Package

1. A& ros T1E H¢:

cd ~

mkdir -p catkin_ws/src

2. ¥ DUKE N W SE ) RS-LiDAR-32 Xt B2 ) ros_rslidar 3%z %] ROS L {F H 3% ~/catkin_ws/src
NI o HBTHCAS P ros_rslidar 3XZf A] LA https://github.com/RoboSense-LiDAR/ros_rslidar
T I %A ros_rslidar 3X3)), 1% EE % Robosense $£HL.

3. TR T T Ar & AT 4 %

cd ~/catkin_ws
catkin_make
4. TN U Bt B T35 1 S 8O

WIXSHOCHAERE TR A TR0 U A, F520K U # P ¥ configuration_data U R A%
£ DL2 launch SCPFHHEE RSO R RIAT,  BEERAR AT H 2 L, Bl

rslidar_pointcloud/data/rs_lidar_32
e 2019 F 9 J UGS B AT EBN U B 800, HBOASECSC I & 81795 R,

AR S S S A AR
D.3 fc & H i IP

PRI\ RS-LiDAR-32 [H{HE T, e B B RS HERA 1P ik 4“192.168.1.102”, FM
i 9“255.255.255.0”, MEANFEBLE .

Mt & 5ei G, nI LA ifconfig 2 BB A IP & B A .

56



RS-LiDAR-32 FI /Tt

D.4 EK B~

1. 4 RS-LiDAR-32 ML 2 M fix, JFH L, 1217, SSf7Hfhii) F LiDAR 4 .
2. f# i ros_rslidar £ B [ $2 4L ) launch XAFI2 47 K 8 8 SLif B B8a 110 SR Y, 1%

launch X447 F rslidar_pointcloud/launch. ] HF—/N&iis4T:

cd ~/catkin_ws
lsource devel/setup.bash

roslaunch rslidar_pointcloud rs_lidar_32.launch

3. R A BT

rviz

SR )5 % B Fixed Frame N rslidar, 7 Il PointCloud2 257 ()34 /2 I 1% & topic N rslidar_points.

Pitch 0.4548
» FocalPoint 3.4093;3.1221; 3.

nce Frame
£
unt 0
1

<Fixed Frame>
o

Lines
160, 160; 164

nnnnn

Axis z
Autocompute val... &
Use Fixed Frame

ROS Time: 151316887290 | ROS Elapsed: [22.34 wall T 1513168872.93 | wall Elapsed: |22.30 Experimental

Wheelz Zoom. shift: More options. 30fps

K D-1 rviz &7~ RS-LiDAR-32 & =i

Reset | Left-Click: Rotate. Middle-Click: Mave X/Y. Right-Click/Mouse

D.5 EEELHIE

7] LRI ros_rslidar SRAGARAF 15 2k pcap SCEFRMT A = B 34T R o
1. &4 rs_lidar_32.launch XA RN (REESHRC AL AR —1T) -

<launch>
<arg name="model" default="RS32" />
<arg name="device_ip" default="192.168.1.200" />
<arg name="msop_port" default="6699" />

<arg name="difop_port" default="7788" />
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<arg name="lidar_param_path" default="$(find rslidar_pointcloud)/data/rs_lidar_32/"/>
<node name="rslidar_node" pkg="rslidar_driver" type="rslidar_node" output="screen" >
<param name="model" value="$(arg model)"/>
<param name="device_ip" value="$(arg device_ip)" />
<param name="msop_port" value="$(arg msop_port)" />
<param name="difop_port" value="$(arg difop_port)"/>
<param name="pcap" value="75/7.pcap HIZEXIEHEIE"/>
</node>
<node name="cloud_node" pkg="rslidar_pointcloud" type="cloud_node" output="screen" >
<param name="model" value="$(arg model)"/>
<param name="curves_path" value="$(arg lidar_param_path)/curves.csv" />
<param name="angle_path" value="$(arg lidar_param_path)/angle.csv" />
<param name="channel_path" value="$(arg lidar_param_path)/ChannelNum.csv" />
</node>
<node name="rviz" pkg="rviz" type="rviz" args="-d $(find rslidar_pointcloud)/rviz_cfg/rslidar.rviz" />

</launch>

2. TP &, JEAT 1 KRR

cd ~/catkin_ws

lsource devel/setup.bash

roslaunch rslidar_pointcloud rs_lidar_32.launch

3. AR LN HIEL 36—,
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fiz E S E4
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H
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LE—
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FisR F AL 3R

0N 18 P, I e SO B IR Y 2 AR IR R BURS AT RT3, AN ZEH LM AT
LA

B R b PR S8 S A ™ R AR SO T IR SR AR E AL AL IR L, S AL A e B AN RE
dmm. 2R R IM U U ARG S 5, AT B T ROE R IE I ECR.

WO TR IR 2RI, W RBOEE IR BN AR B 2 2 T, 3 O 2 T 2 1)
Il BE R RO IE R, BRSO R IL.

WOt T R 2R A, BURH A BEAS WG 90 FE, MR A eI K& X Mot & IE

110. Sum

H1: FAMEET

.
u 1/4- 204 8|44
_ HHEERT B

2 < @3, BamE 1L 4
4 % % 3am
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fii3% G EIK MSOP F1 DIFOP S-2Y {5t B i 3

MR 2 5 5 18 RS-LiDAR-32 <%t MSOP 1 DIFOP W 2% ALty £, w] LLff
wireshark T. Hid €A Py 255K [X 43 MSOP F1 DIFOP A )% Hi 3t 11, T 7E RSView H13E47 Data
Port ¥ & A

R RN, JFHA BRSO, 53 wireshark, EREIEFFIMN O, FFHEIMEIDRE.
7E 8 BRI pE A i\ data.data[0:1]==55 ik = AT LU 3E A i MSOP &, 7E Info
A ] USRI S5 0 i MSOP 3 115, il G-1 frzw: [RI¥4 A data.data[0:1]==a5 ik
=] LAAS 2 ik £l o DIFOP 3t 1%, Wil G-2 s

G-2 wireshark i J& DIFOP iy -5 /514
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[ [data datalo:1]==55 | [] -] wifss
No.. " Time Source Destination Protocol Length Info
= 1 0.000000 192.168.1.181 192.168.1.102 UDP 129@ Len=1248
2 0.001217 192.168.1.181 192.168.1.102 UDP 129@ 178151781 Len=1248
3 09.002578 192.168.1.181 192.168.1.102 UDP  129@ 178151781 Len=1248
4 0.903728 192.168.1.181 192.168.1.192 UDP 1290 178151781 Len=1248
5 8.004990 192.168.1.181 192.168.1.102 UDP 129@ 178151781 Len=1248
6 0.006017 192.168.1.181 192.168.1.102 UDP  129@ 178151781 Len=1248
7 0.007218 192.168.1.181 192.168.1.192 UDP 1290 178151781 Len=1248
8 0.008606 192.168.1.181 192.168.1.102 UDP 129@ 1781>1781 Len=1248
K G-1 wireshark i3 i€ MSOP ¥ 15 5%
(A dsts. datalo:11==a5 | B -] %5
No.. : Time Source Destination Protocel Length Info
= 59 §.069440 102.168.1.181 192.168.1.102 UDP  120¢[778857788] Len=1248
144 .169413 192.168.1.181 192.168.1.182 UDP 1298 7788-7788 Len=1248
220 0.270128 192.168.1.181 192.168.1.182 UDP 1200 77887788 Len=1248
312 9.369404 192.168.1.181 192.168.1.182 UDP 1298 7788-7788 Len=1248
397 0.469690 102.168.1.181 192.168.1.102 UDP 1200 7788+7788 Len=1248
482 9.570183 192.168.1.181 192.168.1.162 UDP 1298 7788-7788 Len=1248
565 0.669489 102.168.1.181 192.168.1.102 UDP 1200 7788+7788 Len=1248
650 0.769427 192.168.1.181 192.168.1.162 UDP 1298 7788-7788 Len=1248
735 0.270070 102.168.1.181 192.168.1.102 UDP 1200 7788+7788 Len=1248



RS-LiDAR-32 FI /Tt

fiF H £ RIBEBE
H.1 FEEER

THEIR 2 RS-LiDAR R A1 240 7F 52 BE M D B A I = H I 2, 75 A 2 44 W] g 2= 152
NS

HISEAGHBCE LI MM, 72 R E B TS R AT, Sl
SO TR AL ) IR H AR
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